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Micros oft Word 2016

Creating a Document
with a Title Page, Lists,
Tables, and a Watermark

Objectives
You will have mastered the material in this module when you can;
* Border a paragraph * Sort paragraphs and tables
* Change paragraph indentation * Use the format painter
* Insert and format a SmartArt graphic * Add picture bullets to a list
* Apply character effects * Create a multilevel list
* Insert a section break * Modify and format Word tables
* Insert a Word document in an open * Sum columns in a table
document

* Create a watermark

* Insert formatted headers and footers » Change theme fonts

Introduction

During the course of your business and personal endeavors, you may want or need
to provide a recommendation to a person or group of people for their consideration.
You might suggest they purchase a product, such as a vehicle or books, or contract a
service, such as designing their webpage or remodeling their house. Or, you might try
to convince an audience to take an action, such as signing a petition, joining a club,
visiting an establishment, or donating to a cause. You may be asked to request funds
for a new program or activity or to promote an idea, such as a benefits package to
company employees or a budget plan to upper management. To present these types of
recommendations, you may find yourself writing a proposal.

A proposal generally is one of three types: sales, research, or planning. A sales
proposal sells an idea, a product, or a service. A research proposal usually requests

funding for a research project. A planning proposal offers solutions to a problem or
improvement to a situation.




Microsoft Word 2016

Project — Sales Proposal

Sales proposals describe the features and value of products and services being offered,
with the intent of eliciting a positive response from the reader. Desired outcomes
include the reader accepting ideas, purchasing products, contracting services,
volunteering time, contributing to a cause, or taking an action. A well-written proposal
can be the key to obtaining the desired results.

The project in this module follows generally accepted guidelines for writing
short sales proposals and uses Word to create the sales proposal shown in Figure 4-1.
The sales proposal in this module is designed to persuade readers to patronize an
animal clinic. The proposal has a colorful title page to attract readers’ attention. To add
impact, the sales proposal has a watermark consisting of animal paw prints, positioned
behind the content on each page. It also uses lists and tables to summarize and highlight
important data.

In this module, you will learn how to create the sales proposal shown in
Figure 4 1. The following roadmap identifies general activities you will perform
as you progress through this module:

1. CREATE a TITLE PAGE for the proposal.
INSERT an EXISTING Word DOCUMENT in the proposal.

These Aee the
things you will
do. kecp reading .

CREATE 2 HEADER AND FOOTER in the proposal.
EDIT AND FORMAT UISTS in the proposal.

wvi B e b

EDIT AND FORMAT TABLES in the proposal.
6. CREATE 2 WATERMARK in the proposal.

'I_’_cﬁun_}!llord and Change Word Settings

The following steps run Word, display formatting marks, and change the zoom
to page width.

o Run Word and create a blank document in the Word window.

_—

e If the ‘Show/Hide 1 button (Home tab | Paragraph group) is not selected already, click
it to display formatting marks on the screen.
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BTW

Normal Style
If your screen settings
differ from Figure 4-2, it s
possible the default setungs
in your Normal style have
been changed. Normal style
settings are saved n a file
called normal dotm file. To
restore the original Normal
style settings, exit Word and
use File Explorer to locate the
normal.dotm file (be sure that
hidden files and folders are
displayed, and include system
and hidden files :n your search
you may need to use Help
10 assist you with these tasks).
Rename the normal.dotm
file as oldnormal dotm. After
renaming the normal dotm
file, 1t no longer will exst as
normal.dotm. The next time
you run Word, it will recreate
a norma! dotm file using the
original default settings

CONSIDER THIS %

three different fonts because too many fonts ¢

To_ Cbange_Thelpe_ColoE )

Recall that Word provides document themes, which contain a variety of color
schemes and other effects. You should select a theme that includes colors that reflect
the goals of a sales proposal. This proposal uses the Celestial document theme. The
following steps change the document theme.

o Click Design on the ribbon to display the Design tab.

e Click the Themes button {Design tab | Document Formatting group) to display the

Themes gl & theme coloR of Your Cheice

9 Click in the Themes gallery to change the document theme to the selected
theme,

Creating a Title Page

A title page is a separate cover page that contains, at a minimum, the title of a

document. For a sales proposal, the title page usually is the first page of the document.

Solicited proposals often have a specitic format for the title page. Guidelines for
the title page of a solicited proposal may stipulate the margins, spacing, layout,
and required contents, such as title, sponsor name, author name, date, ete. With an
unsolicited proposal, by contrast, you can design the title page in a way that best
presents its message.

How do you design an eye-catching title page?
The title page is the first section a reader sees on a sales proposal. Thus, it is important that the title page appropriately reflects
the goal of the sales proposal. When designing the title page, consider its text and graphics.

« Use concise, descriptive text. The title page should contain a short, descriptive title that accurately reflects the message of
the sales proposal. The title page also may include a theme or slogan. Do not place a page number on the title page.

« identify appropriate fonts, font sizes, and colors for the text. Use fonts that are easy to read. Avoid using more than
an make the title page visually confusing. Use larger font sizes to add impact to

the title page. To give the title more emphasis, its font size should be larger than any other text on the title page. Use colars
that complement one another and convey the meaning of the proposal.

o Use graphics to reinforce the goal. Select simple graphics that clearly communicate the fundamental nature of the
proposal. Possible graphics include shapes, pictures, and logos.

« Use colors that complement text colors. Be aware that too many graphics and colors can be distracting. Arrange graphics

with the text so that the title page 1s attractive and uncluttered.

The title page of the sales proposat in this module (shown in Figure 4—1a) contains a colorful title that is surrounded by a
border with some shading, an artistic graphic with text, a colorful slogan, and the faded paw prints image in the background

The steps in the next several sections create this title page. The faded image

this module.

'_I‘o Format Cha_racters

The title in the sales proposal should use a large font size and an easy-to-read

font, and should be the focal point on the page. Why? To give the title more emphasis, its
fout size should be larger than any other text on the title page. The following steps enter the
title, Dover Park Animal Clinic, with the first two words centered on the first line and

the second two words centered on the second line.

of the paw prints is added to all pages at the end of
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, BTW =

Click Home on the ribbon to display the Home tab. The Ribbon and [*]
. =

Click the Center button (Home tab | Paragraph group) to center the paragraph that Screen Resolution o
i S Word may change how the bud
will contain the title. groups and buttons within the e
groups appear on the nbbon, 3

Click the Font arrow (Home tab | Font group). Scroll to and then click ‘Bernard MT depending on the computer
Condensed’ {or a similar font) in the Font gallery, so that the text you type will use the or mobile device screen

selected font. resolution. Thus, your ribbon
may look different from the

Click the Font Size arrow (Home tab | Font group) and then click 72 in the Font Size ones in this book if you are

gallery, so that the text you type will use the selected font size. using a screen resolution

other than 1366 x 768.

Type Dover Park and then pressthe ENTER key to enter the first line of the title.

Click the Font Color arrow {Home tab | Font group) and then click a colo 18 OF ‘0 W
0y(e, in the Font Color gallery, so that the text you type will use the
selected font color.

Type Animal Clinic asthe second line of the title (shown in Figure 4-2).

o 00 6 0 oo

1 CREATE TITLE FAGE | 2 INSERT EXISTING DOCUMENT | 3 CREATE HEADER & FOOTER

TO BO rder a Pa rag ra ph 4 EDIT & FORMAT LISTS | S EDIT &% FORMAT TABLES | 6 CREATE WATERMARK

If you click the Borders button (Home tab | Paragraph group), Word applies the most recently defined
border, or, if one has not been defined, it applies the default border to the current paragraph. To specify a border
different from the most recently defined border, you click the Borders arrow (Home tab | Paragraph group).

In this project, the first line of the title in the sales proposal (Dover Park) has a 6-point olive green border
around it. Why? You want the title to stand out more than the rest of the text on the title page. The following steps add
a border to all edges of a paragraph.

Font Size

® Position the — | Center button
. . o selected B ‘ShowrHide
insertion pointin | e 1" selected
" R orces ROAEET
the paragraph to R | button |\ 2 P

border, in this case,
the first line of the

+ A
5o 2.7 rans) Borders arrow (touch screensmay | kRepisce
%ﬂ_ not have a separate Borders arrow) | - Select-
= tor

¥ Format Painter

depboard 1] Font Eaati ~
document. i o £ AR et tef Al Toa Border P A
0 Left ord s
I SOl G a‘gm:«:’e- Borders gallery
arrow (Home tab | b 52T T

Ho Border
Paragraph group) to T
display the Borders . I"“‘:‘;": dos
gallery (Fig ure 4" 2)- , l‘ns-del;icmor.nl Beeder

title entered

— L4000\

Insate fert:cal Barder

insertion
point

2 Hongental Line

B Qeaw Tuble

B Viea Godines

B Bgrdess and Shading...

‘Borders and
Shading’ command

Note: To help you locate screen elements that =
are referenced in the step instructions, such "::::t‘o‘r-‘asye‘}:; - =
as buttons and commands, this book uses red |

A | Zoom
boxes to point to these screen elements. \ LpercentA\
1 dwerss (2 ]' 5 - [ + 1

Figure 4-2
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12

Borders and Shading

e Click Borders and Shading in the — 1, dialog box . o ercrTTROC AaBoCeon Aol
Borders gallery to display the | - % A & l B- o - fHema [T berarg! Hesing?  Tale  Sbide  SubtleEm.  Emeh
ma Stptes

Borders and Shading dialog box.

# Click Box in the Setting area
{Borders and Shading dialog box),
which will place a border on each
edge of the current paragraph.

» Click the Color arrow and then
dick O Cofor of .

oUR Chojce, nthe

Color palette to specify the border

[ 4
color.
s Click the Width arrow and then
click 6 pt to specify the thickness i :
of the border (Figure 4-3). \ :::‘;;“;:c’;":ﬁ‘:: ) cnen
you click Bex in
For what purpose are the buttons 'I, Setting area OK button

g in the Preview area used? L — R

Berders and Shatng

Tl on apram Deiow OF
wse buttons 1o soply borden

s

preview of
selected
settings

s 68888688

Figure 4-3
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» Click the OK button (Borders and
Shading dialog box) to place the

NA A L spmntes astbiex AJBDCE Aates QY s saancs sencs

\b order shown in the preview CRERL -l v-A : B f1eTT0 | ted hotee deseg! esdegl e T;:Poml olive green
\ T O area of the dialog box around . . . o . ot | border placed around
\ . ErE . ' & ' ! gurrent paragraph

the current paragraph in the | e . : ; — e,
F\“ document (Figure 4-4). 'i I

A

y _— E - — S
[
How would | remove an existing
g border from a paragraph? b
\ insertion L/J
w poiny [T — . . T e

| Animal Clini

Figure 4-4 5|

1. Click "Borders and Shading’ button (Design tab | Page Background group), click Borders tab (Borders and Shading dialog box), select desired
border, click OK button

2 8

To Shade a Paragraph and Change Font Color

- M

To make the first line of the title of the sales proposal more eye-catching, it is
shaded in teal. When you shade a paragraph, Word shades the rectangular area behind
any text or graphics in the paragraph from the left margin of the paragraph to the right
margin. If the paragraph is surrounded by a border, Word shades inside the border.
The following steps shade a paragraph and change font color.

o With the insertion point in the paragraph to shade, the first line in this case (shown
in Figure 4-4), click the Shading arrow (Home tab | Paragraph group) to display the
Shading gallery.

- @
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9 click* (A CO!OR aFVﬂ ue Cho;ce, " in the Shading gallery to shade the

current paragraph (shown in Figure 4-5).

9 Drag through the words, Dover Park, in the first line of the title to select the text.

r

To Border Another Paragraph

‘Io make the second line of the title of the sales proposal (Animal Clinic) more
eye-catching, it has a 6-point gold border around it. The following steps add a border
to all edges of a paragraph.

BTW
Touch Screen
Differences

Word Module 4

The Office and Windows
interfaces rmay vary if you are

Position the insertion point in the paragraph to border (in this case, the second using a touch screen. For this
paragraph containing the text, Animal Clinic). 18a50n,-you might notice that

the function or appearance
Click the Borders arrow (Home tab | Paragraph group) to display the Borders gallery of your touch screen differs
and then click "Borders and Shading’ in the Border gallery to display the Borders and  slightly from this module’s
Shading dialog box. Cllilicl)

Click Box in the Setting area (Borders and Shading dialog box), which will place a
border on each edge of the current paragraph.

Click the Color arrow and then click olo v OFY UL chﬁtlt(lf, *in the
Color palette to specify the border color.

If necessary, click the Width arrow and then click 6 pt to specify the thickness of the border.

Click the OK button to place the defined border shown around the current paragraph
in the document (Figure 4-5).

Q0 60 0 o o

=

Bemard MTEcr 1«

Pate ity BT MR x4 b= ding1 Hesding2 Tk Sobite  Submle b Emphasis g

Lhpboms fa

1 5 . Yoo I Y. e T
r

g font color
changed

A Paragraph 1
o group

T T

paragraph 3
shaded teal i 1 4
: Cp— wd . & L
| blank space i
| below first L 5 i Al ey e
paragraph
tobe = 2 e
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Figure 4-5
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To Change Spacing after a I:-‘ar_agra;_:h_

Currently, a small amount of blank space exists between the two paragraph
borders because Word automatically places 8 points of blank space below paragraphs
(shown in Figure 4-5). The following steps remove the blank space below the first
paragraph.

o Position the insertion point in the paragraph to be adjusted (in this case, the
paragraph containing the text, Dover Park).

9 Display the Layout tab. Click the Spacing After down arrow (Layout tab | Paragraph
group) as many times as necessary until 0 pt is displayed in the Spacing After box to
remove the space below the current paragraph (shown in Figure 4-6).

g What if | am using a touch screen?

o 1

% CREATE TITLE PAGE | 2 INSERT EXISTING DOCUMENT | 3 CREATE HEADER & FOOTER

To Change Left and Right Paragraph Indent  .cors romarusrs s o s commur maves | & caeate warenmaee

)
@

The borders around the first and second paragraphs and the shading in the first paragraph currently
extend from the left margin to the right margin (shown in Figure 4-5). In this project, the edges of the border
and shading are closer to the textin the titte. Why? You do not want such a large gap berween the edge of the text
and the border: If you want the border and shading to start and end at a location different from the margin, you
change the left and right paragraph indent. A4

The Increase Indent and Decrease Indent buttons (Home tab | Paragraph group) change the left indent

&

iy
o

by Y2-inch, respectively. In this case, however, you cannot use these buttons because you want to change both the e
left and right indent. The following steps change the left and right paragraph indent.

L
(1 &

e Be sure the insertion point is positioned in the paragraph to indent (the first paragraph, in this case). Click the
Indent Left up arrow (Layout tab | Paragraph group) five times so that 0.5" is displayed in the Indent Left box
because you want to adjust the paragraph left indent by this amount {or, if using touch, tap the indent Left box
(Layout tab | Paragraph group) and thentype 0.5 tochange the leftindent).

« Click the Indent Right up arrow {Layout tab | paragraph group} five times so that 0.5" is displayed in the Indent
Right box because you want to adjust the paragraph right indent by this amount (o, if using touch, tap the Indent
Right box (Layout tab | Paragraph group) and then type 0.5 to change the right indent} (Figure 4-6).

8 8

e .
Paragraph
5 '; 0

v Layout
i Breaks -

& A &8

. R B i iDlneMumbors = TSieke 05 iERelose 0pt Spacing After : | "9'“"‘3_’9'"-'_
Marging Orentation  Sace  Cohumns o — . [ dowen arrow Selecuan

- - - . of Hyphenation* ¢ Right: |35° gz Adter: Ops ; 1 Pane -

Page Seiup : o Paragranh s Hrarge i ¥ -
< 15 E T ;i 1 -] i i ' [ i ' ]
Indent Right
] = up arrow f I 3 v v : 3 TR
- — G REr b it

i & = - i 8
Eﬂ margin § J '\ Left Indent and Right Indent markers at
y ) 0.5", visually showing location of new
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= B &8
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Figure 4-6
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@ Experiment

¢ Repeatedly click the Indent Right and Indent Left up and down arrows (Layout tab | Paragraph group) and watch
the left and right edges of the current paragraph change in the document window. When you have finished
experimenting, set the left and right indent each to 0.5".

12

° Repeat'Step 1 for the second paragra'ph, so that the paragraph containing the words, Animal Cliﬁic, also has a left
and right indent of 0.5 {(shown in Figure 4-7).

Other Ways
1. Drag Left Indent and Right Indent 2. Click Paragraph Settings Dialog Box Launcher 3. Right-click paragraph (or, if using touch, tap
markers on ruler (Home tab | Paragraph group), click Indents ‘Show Context Menu' button on mini toclbar},
and Spacing tab (Paragraph dialog box), set click Paragraph on shortcut meny, click Indents
indentation values, click OK button and Spacing tab (Paragraph dialog box), set

indentation values, click OK button

To Clear Formatting

The title is finished. When you press the ENTER key to advance the insertion
point from the end of the second line to the beginning of the third line on the
title page, the border will be carried forward to line 3, and any text you type will
be a 72-point Bernard MT Condensed Purple, Accent 1 font. The paragraphs and
characters on line 3 should not have the same paragraph and character formatting
as line 2. Instead, they should be formatted using the Normal style. The following
steps clear formarting, which applies the Normal style formats to the location of the
insertion point.

o If necessary, press the END key to position the insertion point at the end of line 2, that
is, after the ¢ in Clinic.
e Press the ENTER key.

9 Display the Home tab. Click the ‘Clear All Formatting’ button (Home tab | Font group)
to apply the Normal style to the location of the insertion point (Figure 4-7).

Could I have clicked Normal in the Styles gallery instead of the Clear All Formatting
button?
Yes.

‘Clear All
Formatting’ button [T

Pred -

I Cabbrody) *+ 11+ A A Aa “Uee BEEEE (0] | sanocenc| asgbeede AaBbi AaSkier PAB: scguccr acbbten damicits a1 -
Pl'sle “r. Panter BT M- x X @ EE s b-E- THermal | THo'lpac. Headingl  Heading? Title Subtale  SublleEm._  Emphas - 1 Setect
Chpbosid . Font e Paragigph e flyles ©  Eddting ~
R .o . + TNV ENE T
"p.a.ragraph = y : ey
—_— A R . 1 , e
[ ptseee | | FERWREwwSEE ~ GHLEN *‘
1- point returned to !
| formats defined by a
Normal style |
| L .\‘] SR AR e T P B R e e i 5 13 e S
edges of border and shading moved in |
| 0.5" from left and right margins
IL-._—-—--""'"_ ; i ‘—-.-..___________‘____'_"_.“_______._..——

Figure 4-7
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o Save the title page (A$ mﬁ'nucl'ed b\' Mﬁj N\\lﬁﬂ{

< | Why should | save the title page at this time?
g You have performed many tasks while creating this title page and do not want to risk
losing work completed thus far.

SmartArt Graphics

Microsoft Office 2016 includes SmartArt graphics, which are visual
representations of information. Many different types of SmartArt graphics are
available, allowing you to choose one that illustrates your message best. Table 4-1
identifies the purpose of some of the more popular types of SmartArt graphics. Within
each type, Office provides numerous layouts. For example, you can select from 40
different layouts of the list type.

Table 4-1 SmartArt Graphic Types
Type Purpose ' i)

List Shows nonsequential or grouped blocks of information.

sees0088080880

Process Shows progression, timehne, or sequential sleps in a process or workflow,

Cycle Shows continuous sequence of steps or events.

Hierarchy lustrates organization charts, decision trees, and hierarchica! relationshups

Relationship  Compares or contrasts conneclions between concepts. (ﬁ;
Matrix Shows relationships of parts to a whole

Picture Uses images to present a message.

Pyramid Shows proportional or interconnected relationships with the largest component at the top or bottom

SmartArt graphics contain shapes. You can add text or pictures to shapes, add
more shapes, or delete shapes. You also can modify the appearance of a SmartArt
graphic by applying styles and changing its colors. The next several sections
demonstrate the following general tasks to ereate the SmartArt graphic on the title
page in this project:

BTW 1. Insert a SmartArt graphic.

Resetting Graphics o e e T .

i you want to remove all 2. Delete unneeded shapes from the SmartArt graphic. W Fells \l o\,

formats from a SmartArt 3. Add shapes to the SmartArt graphic. +

graphic and start over, you , . . h d -
would click the Reset Graphic 4, Add text to the shapes in the SmartArt graphic. W ) ‘0 W Wi “ 0 ; @&
button (SmartAd Tools Design Change colors of the SmartArt graphic \

tab | Reset group), which is 5. g ' ) g l_ ' mf how “‘0 dD (t.
shown in Figure 4-15 6. Apply a style to the SmartArt graphic. —_— .

Keep Reodirg ..

" EEEEREEEREEERENEN.



- To Insert a SmartArt Graphic
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1 CREATE TITLE PAGE | 2 INSERT EXISTING DOCUMENT | 3 CREATE HEADER & FODTER

4 EDIY & FORMAT LISTS | 5 EDIT & FORMAT TABLES | 6 CREATE WATERMARK

{Below the title on the title page is a grouped list SmartArt graphic. Why? The Grouped List SmartArt
graphic allows you to place multiple lists side by side on the document, which works well for the content on this title page.
The following steps insert a SmartArt graphic centered below the title on the title page.

* With the insertion
point on the blank
paragraph below
the title {shown
in Figure 4--7),
click the Center
button (Home tab |
Paragraph group)
so that the inserted
SmartArt graphic
wili be centered
below the title.

# Display the insert
tab.

¢ Click the ‘Insert a
SmartArt Graphic'
button (Insert tab |
lllustrations group)
to display the
Choose a SmartArt
Graphic dialog box
{Figure 4-8).

@ Experiment

document saved with
new file name

o Insert tab
-

‘Insert a SmartArt
Graphic’ button
! Riadlrgn i

s Insert i3 Layne Rritic ety 2 fo s ' {3t & ey
e Choose a SmartArt [ . F ™ Hesder- ick Parts » .
m ] ,_d. @ Ecmﬁ B seore Graphic dialog box | e I LT %
Table  Piclures Omiina Shapes Bty agls - WP O Comment| Middle pane shows list of
5 Pictuocs o dhe Sereenshot - vigeo [ Crensrddenmce layouts for selected type of |
bt o Bhstilion | eunne  Smanan Graphic / SmartArt graphic

{llustrations

'%“. T

snaped.

| insertion point and
paragraph centered

Figure 4-8

* Click various SmartArt graphic types in the left pane of the dialog box and watch the related layout choices appear

in the middle pane.

* Click various layouts in the list of layouts in the middle pane to see the preview and description of the layout
appear in the right pane of the dialog box.

12

<t
L
S
-
<)
p
©
T
2

" 1st
o Praceis
b Cyele
M Hurarchy 3 3
...... ¥ & Resvoniig L nght_ pane shows
selecting a specific ] _' 4 N Fin AT s preview and
- type-narraws- ] & e 7 ST i (-descriptionof |
layout choices in B Promd i Basic Hioch st | selected layout |
i_llst to right o Picture 2 - 4 4 UsE 1o show non-Hquentul 91 grovped i
= = 3 Ofice com 9 biocks of ntarmation. hiasswizes ioth
L nanzental ind verbical dispisy 1gace for

i isti . awm.:""h—- | preview and :
e Click List in the left pane (Choose fres - o Scremmshal vaw = description of
GRS | Choose o SmartArt Graphic selected [ait?f_l pox

a SmartArt Graphic dialog box) to

display the layout choices related =] f
to the selected SmartArt graphic ] - ; ;
—= = Sl
» Click Grouped List in the middle Hiraciy B A LR
R . . elationt TEEETR e e =3 14
pane, which displays a preview ;'; :‘: ’ ESLEL £ ﬁ | ﬁ = =
and de.scnptlop of the selected A enmg LD 88 o ao o008 P, '
Iayout in the I‘lght pane 51 Prtare e e N Uie o show Qroups and 1ub.gloups  a
. @ Office.com otinfarmancn, of stept and sub-iteps ¥
(Figure 4-9), : @ e ot et Leve 1 R
B ! Cotrstpons e e siep
5 | :1_;! = ;:‘de:?u(:r:lale:lcnl:vﬂs.;:ge, b '
i-m [To ] ana ||
Grouped List R Sesmsssr———

layout selected [

Figure 4-9
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(3] .

# Click the OK button
to insert the selected
SmartArt graphic
in the document
at the location of
the insertion point
{Figure 4-10).

<« | What if the Text
g Pane appears next
to the SmartArt

4T VgV

| each shape
| in SmartArt
| graphic has

placeholder

Twarsme & gl
PR

text associated |

SmartArt Tools and subordinate
Design and Format tabs automatically
appear when SmartArt graphic is
selected n document

G HEE WEW OO WY W W

[y o e

+ it S

e

More button 1 4 i

Text] [Text]

grouped list
SmartArt graphic |
inserted below title |

w3

| border around
- SmartArt graphic
| does not print —

graphic? with it | i | useittoresize |
1 | and move the i
SmartArt graphic
|
one shape automatically
l i =——— selected when you i =l ]
B L | i { insert SmartArt graphic ! TR - 4+ e

Figure 4-10

Can i change the layout of the inserted SmartArt graphic?

To Delete Shapes from a SmartArt Graphic

1 CREATE TITLE PAGE 2 INSERT EXISTING DOCUMENT 3 CREATE HEADER & FODTER

4 EDIT & FORMAT LISTS 5 EDIT & FORMAT TASLES | 6 CREATE WATERMARK

The Grouped List SmartArt graphic initially has three outer groups that consist of nine different shapes
{shown in Figure 4—10). Notice that each shape in the SmartAre graphic initially shows placeholder text, which
indicates where text can be typed in a shape. The next step in this project is to delete one entire group. Why? The
SmartArt grapbic in this project consists of only two major groups (Puticnts and Services). The following steps delete
one entire group, or three shapes, in the SmartArt graphic.

1

¢ Click one of the shapes in the
rightmost group in the SmartArt
graphic and then press the DELETE
key to delete the selected shape
from the graphic (or, if using
touch, tap the Cut button {Home
tab | Clipboard group)).

(2

e Repeat Step 1 to delete the next
shape in the rightmost group.

13

¢ Repeat Step 1 to delete the
rightmost group and notice the
other shapes resize and relocate
in the graphic (Figure 4-11).

I Other Ways

:::: Mo isix.shapes re:':;illl in |H === J:J l.. lll EE
.’_‘::Mtf:l..cﬁ SmartArt graphic ] R

A A

Text Pane
control is a

{ toggle that |
displays and
hides Text

| Pane

Figure 4-11

l 1. Click Cut button {Home tab | Clipboard group}

2. Right-click selected shape, click Cut on shortcut menu

EEREEEREEEREEEREERERE RN D

2 BE 2 8 8

2

e
a
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To Add Text to Shapes in a-SmartArt Graphic

1 CREATE TITLE PAGE | 2 INSERT EXISTING DOCUMENT | 3 CREATE HEADER & FOOTER

4 EDIT & FORMAT LISTS | 5 EOIT & FORMAT TABLES | 6 CREATE WATERMARK

The placeholder text in a shape indicates where text can be typed in the shape. The following steps add
text to the three shapes in the first group via their placeholder text. Why? After entering the text ire these three
shapes, you will need to add two more shapes to finish the content in the group.

(1

» Click the top-left shape to select it and then type Patients to replace the placeholder text, [Text], with the

entered text.

How do | edit
placeholder text if |
make a mistake?

Q&A

T MovelUp

# Promote

Click the placeholder + Dsmate 4 MoveDown | 7
text to select it and ;:';;’;;.:“ b Emon
then correct the selected

entry.

TWhat if my typed
text is longer than
the shape?

The font size of the
text may be adjusted
or the text may
wordwrap within the
shape

2

o Click the middle-left
shape to select it and
then type Birds
as the new text.

text entered

shape
selected

|
1’
|

= Click the lower-left
shape to select it and
then type Cats as

the new text
(Figure 4-12).

Other Ways

Figure 4-12

| 1. click Text Pane control, enter
text in Text Pane, close Text Pane
Pane, click Text Pane button again

To Add Shapes to a SmartArt Graphic

2. Click Text Pane button (SmartArt Tools Design
tab | Create Graphic group), enter text in Text

3. Right-click shape {or, if using touch, tap Edit Text
butten on mini toolbar), click Exit Edit Text on
shortcut menu, enter text

1 CREATE TITLE PAGE | 2 INSERT ENISTING DOCUMENT | 3 CREATE HEADER & FOOTER

4 EDIT & FORMAT LISTS | 5 EDIT & FORMAT TABLES | & CREATE WATERAMARK

The following steps add shapes to the SmartArt graphic. Why? Each group in this project bas four subordinate

items, which means two shapes need to be added to each group.

# Click the Add Shape button (SmartArt Tools Design tab | Create Graphic group) to add a shape to the SmartArt
graphic (or, if using touch, tap the Add Shape button (SmartArt Tools Design tab | Create Graphic group) and then

tap '‘Add Shape After).

12)

* Repeat Step 1 to add the final shape to the group.

<
&
=
T
0
b=
o
t
2
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(3] ?‘{Nﬂs moy e a diff erent colow -

o Click a subordinate shape on the right (one of the purple shapes) to select it.
e Repeat Steps 1 and 2 so that the same number of shapes appear on the right and left sides of the SmartArt graphic.

4

o Enter the text in the shapes as shown in Figure 4-13.

Smarntart Tools
B Add Shape button DENTERRE Design tab

Desga 0 Lot

TAdd Shape + & Promate T MeveUp oo

T-1 PR ompoEE - 1
] Add Buet ; a1 latel | AR L  mEn amm [
S ; : < { D:-‘ll:!l i =l . oo Gag IH 'II EEE l
R R 2 ; ¥ ma
Miotbame & Roghttaler 2 1 | EEE E= e HEW WmE D0 rtArt |

|
graphic  }x
Coualy Graphs Lipeats smastrt eyl l selected -
I G ./‘ Wi ' i i ] ¥ C it P iy = - -

Create |

Create
Graphic

o Patients Services

' Birds

Boarding

Cats Grooming

subordinate ;

E 'l

. 5 Woim _4__ shap.s

Dogs Surgery

shapes / - '

added

-‘_,q_‘_“
shapes i 1
fagetad)  Aweh  [F added . ® 'l % ] * i |
Figure 4-13
Other Ways

1. Click Add Shape arrow (SmartArt Tooals Design 1ab), click desired 2. Right-click paragraph (or, if using touch, tap 'Show Context Menu’
shape position button on mini toolbar), point to Add Shape on shortcut menu, click
desired shape position

1 CREATE TITLE PAGE 2 INSERT EXISTING DOCUMENT | 3 CREATE HEADER & FOOTER

TO Change c0|0rs Of a SmartArt Graphic 4 EDIT & FORMAT LISTS & EDIT & FORMAT TABLES ' § CREATE WATERMARK

Word provides a variety of colors for a SmartArt graphic and the shapes in the graphic. In this project, the
inside shapes are green, instead of purple. Why? The current dark purple color competes with the title, so you want a
softer color for the shapes. The following steps change the colors of a SmartArt graphic.

« With the SmartArt graphic selected (shown in Figure 4-13), click the Change Colors button {SmartArt Tools Design
tab | SmartArt Styles group) to display the Change Colors gallery.

g What if the SmartArt graphic is not selected?
o e
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* Point to €etorful
Rerge—pAccent
Cotors3ted’ in
the Change Colors
gallery to display
a live preview of
the selected color
applied to the
SmartArt graphic
in the document
(Figure 4-14).

@ Experiment

Point to various
colors in the Change
Colors gallery and
watch the colors of
the graphic change
in the document
window.

o

Yowe choice

" Colors button

! i}

Change
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Colorful

LR
EEm

Avcent 1

BEF == mas @s

Accent 2

LOC EEE BeD NEE mSE
COC smm Mas WeN OES
Accent 3

% | cotor of SmartArt graphic |
changes, including color

o y 6T‘|i'sgsamh0\?rmg“ve :

i preview of color to which Py a

you are pointing in gallery [} T e

Figure 4-
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o Change | | W
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.
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More
button

SmartArt
Styles group

pointer on
‘Colorful

Range - Accent
Colors 3 to 4"

¥

Change Colors |
gallery i

—— ]
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¢ Click 'Ealorful-fange—iecent-Cotorsdtad in the Change Colors gallery to apply the selected color to the SmartArt

graphic.

To Apply a SmartArt Style

1 CREAJE TITLE PAGE | 2 INSERT EXISTING DOCUMENT | 3 CREATE HEADER & FOOTER

4 EQIT & FORMAT LISTS | 5 EDIT & FORMAT TABLES | § CREATE WATERMARK

The next step is to apply a SmartArt style to the SmartArt graphic. Why? Word provides a SmartArt Styles
gallery, allowing you to change the SmartArt graphic’s format to a more visually appealing style. The following steps

apply a SmartArt style to a SmartArt graphic.

» With the SmartArt graphic still selected, click
the More button in the SmartArt Styles gallery
{shown in Figure 4-14) to expand the SmartArt
Styles gallery.

* Point to Moderate Effect in the SmartArt Styles
gallery to display a live preview of that style
applied to the graphic in the document
(Figure 4-15),

@ Experiment
# Point to various SmartArt styles in the SmartArt

Styles gallery and watch the style of the graphic
change in the document window.

@ Viuechice
¢ Click Mederate-Effect in the SmartArt Styles
gallery to apply the selected style to the
SmartArt graphic.

Colors -

- ,.', Bast Match for Docament
2] T Chunge

AaEE aEo
AfE BEMm

in

pointer on
Moderate Effect

i s

(MEKY] HRE Wags n d

fmm Lﬁh lm@nllﬂ uh; Reset
Graphic
button

\ expanded SmartArt
Styles gallery —
yours may be
displayed differently

style of SmartArt graphic
thanges, showing live

| preview of style to which
you are pointing in gallery

Figure 4-15
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To Modify Character Spacing and Format - R
N . . . 1 CREATE TITLE PAGE (L ISTIN UMENT | 3 CREATE HEADER & FODTER
Cha racte rs US| ng the Font Dlalog BOX 4 EDIT & FORMAT LISTS | 5 EDIT & FORMAT TABLES | & CREATE WATERMARK

In this project, the next step is to enter and format the text at the bottom of the title page. This text is the
theme of the proposal and is formatted so that it is noticeable. Its characters are a 36-point, italic, purple Bernard
MT Condensed font. Each letter in this text is formatted in small caps, which are letters that look like capital

. letters but are not as tall asa typical capital letter. Also, you want extra space between each character so that the .

ried text spans the width of the page.

;‘ Thus, the next steps apply all of the formats mentioned above using the Font dialog box. Why? Although
o yau could use buttons on the Home tab to apply somne of these formats, the small caps effect and expanded spacing are applied
J% using the Font dialog box. Thus, you apply all the formats using the Font dialog box.

. o

;‘l& g « Position the insertion point on the paragraph mark to the right of the SmartArt graphic and then press the ENTER
';':-' : key to position the insertion point centered below the SmartArt graphic.

» Type Full-service, friendly care for your pets!l

« Select the sentence you just typed and then click the Font Dialog Box Launcher (Home tab | Font group) to display
the Font dialog box. If necessary, click the Font tab in the dialog box to display the Font sheet.

« Scroll to and then click ‘Bernard MT Condensed’ in the Font list {Font dialog box) to change the font of the selected
text.

» Click Italic in the Font style list to italicize the selected text.

« Scrofl through the Size list and then click 36 to change the font size of the selected text.

« Click the Font color arrow and then click {§ { 0‘ e 0 F .\{GI\A,W.I Chl)l ce. N the Font color palette to change

-F' the color of the selected text.

« Click the Small caps check box in the Effects area so that each character is displayed as a small capital letter
{Figure 4-16).

" .
., Home tab

S e DU IE R Font dislog box
e, Joow AT ETETT s b e
Ve Cabnilody - 1L - & & Aas e 7 - Siei 80 aamncepe aamboene AaBbC: cssoccl A nasvcer aopocene aosveeon | o L
Paste . 2 .8 pa » = TR e st teadma } Tie b
e omatbunter B 1 W TR R o 23 [ Fonttab Joomal | 7 Mz Sgae Wi | Headmg e Subtwe Subllefn Emphass o poc.
ihugoard % roal e e A Egaing .
S
.'_l- . VI A / ¥ Font 3 e [ i + f 1 5
i ; Font group * |

Font Dialog
Box Launcher

: - . .&,__
- Ices
L

font.

T e
EIRE

Bemard WT Condermed
Bertin $ans FB Deme

Blackadder MC

.Bodoni MT Botd Hahc

"
; Condensed' selected Bodon: T Black v e |
Font golor u
o Font color arrow

- — Edlecs

- .
2 ::‘:'"":‘:: Small caps chack i. i eaas,
- L DoublESUkeiy oy selected a1 caps
(! [ sugerscupt [] paden
——— ' ] subsumt
| preview of -

current dialog e
| box selections s

TULL-SERVILE, FRIENULY (ARE |

Thut font sbe 55 iAaned for duplay. he (losest matenang shyte will be pirated. paragraph
_ Bk mark to right of
. . b SmartArt graphic
L s_el As Defau_h buttan Setds Qefeult  Ted fifects. -:- Cancel o S — 1"/
text entered i
; and selected = Full-service, friendly-care-for-your-petsiq|
Pagelal L Sl Owewis L 2 {81 T - 1 1%

Figure 4-16
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2

» Click the Advanced tab (Font ,-—“{ Advanced tab } = -—\__m_‘__
dialog box} to display the = e ""“"""'.’..dr

Advanced sheet in the Font dlalog
Adanied
box. (haricter et s;: B Spar.lng By box
# Click the Spacing arrow and | 3padng area i scae 3

then click Expanded to increase :’:": "‘-‘f’“:’l" = :| v G
the amount of space between ;
characters by 1 pt, which is the

default.

* Double-click the value in the
Spacing By box to select it and
thentype 7 because you want
this amount of blank space to be | Previewof text

| with 7 points

displayed between each character. | between each
character

#» Click in any box in the dialog box S
for the change to take effect and
display.a preview of the entered A [sesivuun | senpreed OK button [—{ 7o ] [ e
value in the Preview area :
{Figure 4-17).

Word Module 4

b [ gerning fos fonts:

OpenType Features

Loatues: Hoae

Humber spaong:  Default Tk e
Huoberforme:  Detautt |
Shylist sels: Default -
[0 wrse Contertual Attermates

FULL-YERVIUF; FRIF)

Ths fot stybe is imstaked for display The dotest mptching thle wd b prieked

Figure 4-17

< Can { click the Spacing By arrows

g instead of typing a value in the box?
Yes

» Click the OK button to apply >6-point italic purple Bernard ‘

font changes to the selected caps and expanded
text. If necessary, scroll so that /

ey e \FULL~SERVICE, - FRIENDLY-
(ARE-FOR- YOUR PETS!Y

window.
Figure 4-18

¢ Click to remove the selection
from the text (Figure 4-18).

Cther Ways

1. Right-click selected text (or, if using touch, tap ‘Show Context Menu’ 2. Press CTRL+D, select formats (Font dialog box), click OK button
button on mini toolbar), click Font on shortcut menu, select formats
I (Font dialog box), click OK button

To Zoom One Page, Change Spacing before
and after a Paragraph, and Set Zoom Level

The final step in creating the title page is to adjust spacing above and below the
SmartArt graphic. You want to see the entire page while adjusting the spacing. Thus,
the following steps zoom one page, increase spacing before and after the paragraph
containing the SmartArt graphic, and then set the zoom level back to page width
because you will be finished with the title page.
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3
.<J e Position the insertion point in the paragraph to adjust, in this case, on the paragraph
¥ mark to the right of the SmartArt graphic.

Sy
< N 9 . . .

Display the Layout tab. Click the Spacing Before up arrow {Layout tab | Paragraph

NS \A group) as many times as necessary until 42 pt is displayed in the Spacing Before box
because you want to increase the space above the graphic (or, if using touch, tap the
Spacing After box (Layout tab | Paragraph group) and then type 42 to change the
spacing below the paragraph).

4]

- Click the Spacing After up arrow (Layout tab | Paragraph group) as many times as
6 necessary until 30 pt is displayed in the Spacing After box because you want to
< increase the space below the graphic (or, if using touch, tap the Spacing After box
L {Layout tab | Paragraph group) and then type 30 to change the spacing below the
\s paragraph) (Figure 4-19).
<

(o]

Erlargase Ligihng Rowith o W Spacing Before s
[E % T ; Spacig changed to 42 pt
- ndent i

entire
*% one-page
~| document iz

(T |Dkine Numbers+  *51eh: T 1lBdoe 2pt ] sad displayed in
fatnn 2o . bl Hyphenalion~ & Right. " L4 e @ h' B dgcument i
Page Selup 3 Patagragh < Jre ‘|_‘_'f'nd°vi__ |
/ Shaihd TR Spacing After b g 7
Paragraph changed to 30 pt
group
L o) 'Tii". LR e :ﬁw.
“\'.h"‘_'eil'f"' e .'151
 Animal-Clinicyl e oo | €5
| * space above | .
| S—— et | SmartArt |
=—— graphic
- increased to ! f-a,{!l
Patients  Services | 42points | -
- [I._. e
e | insertion |
j e . : tmi i (/1 point i
space below graphic l___" & il ﬁ'ﬂ
increased to 30 points
e Fori-SERVICE, FRIENDLY
CARE FOR YoUR PETS!Y
— @

Figure 4-19

What if the document spills to two pages?

o
ol
o

~ . T

2 A

G Save the title page again on the same storage location with the same file name.
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<

v

Inserting an Existing Document BTW 3
. Inserting Documents [
in an Open Document Whenyou insetaWord 03
document in another Word g2}

Assume you already have prepared a draft of the body of the proposal and saved it document, the entire inserted é’

5 7 - : . document is placed at the
with the file name, Animal Clinic Draft. You would like the draft to be displayed on a location OF the insertion

separate page following the title page. point. If the insertion point
* In the following sections, you will insert the draft of the proposal below the title s postioned in the middle

page and then edit the draft by deleting a page break and applying styles. th?:;pfasgﬂgger

\(a\“ H pﬂc #ﬂped documcv\f @ Word document, the open

document continues after the
last character of the inserted
T —— document; therefore, pay

'/-\/-\/___\/_\ s . close attention to where the
"'-"\F/-"“‘\ \/ﬂ\ insertion point is positioned

before inserting a document.

C/'5
5
<
m
<
o
=
)
O
<
<o
=
=
M
Z
__|

Sections

fAll Word documents have at least one section. A Word document can be divided
into any number of sections. During the course of creating a document, you will create  BTW
a new section if you need to change the top margin, bottom margin, page alignment, ~ Section Numbers

. " \ ] B If you want to display the
paper size, page orientation, page number position, or contents or position of headers, e gt .

footers, or footnotes in just a portion of the document. the status bar, right-click
The pages in the body of the sales proposal require page formatting different the status bar to display the
from that of the title page. The title page will not have a header or footer; the next two g:;ﬁ?;:iéf;‘;ﬁg;rgﬁ"lze
pages will have a header and footer. When you want to change page formatting for a Customize Status Bar menu
portion of a document, you create a new section in the document. Each section then The section number appears

may be formatted differently from the others. Thus, the title page formatted with no 3t the left edge of the status
bar. To remove the section

h«?ader or footer will be in one section, and the next two pages of the proposal, which number from the status bar,
will have a header and footer, will be in another section. perform the same steps

2 INSERT EXISTING DOCUMENT 3 CREATE HEADER & FOOTER

To Insert a Next Page Section Break 4 EDIT & FORMAT LISTS 5 EDIT & FORMAT TABLES ' & CREATE WATERMARK

When you insert a section break, you spechy whether the new section should begin on a new page. Why?
Sometimes you want a page break to occur with a section break, as in this project. Other times, you do not want a page break
2o occur with a section break (which will be illustrated in a later module). -I\IWWWWW@
the next two pages. Thus, the section break should contain a page break The following steps insert a next page
m@%‘ch instructs Word to begin the new section on a new page in the document.

» Position the insertion point at the end of the title page (following the exclamation point), which is the Jocation
where you want to insert the next page section break.
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« Display the Layout tab. Click the ‘Insert Page and Section Breaks’ button {Layout tab | Page Setup group) to display
‘the Insert Page and Section Breaks gallery {(Figure 4-20).

‘Insert Page ey O Frierren Ve Bees s T : I new file name
and Section - g ) — =
Breaks' button |5 3

| Insert Page [l 1 Abgn-
and Section =
Breaks galle
: - | Eage eaks gaveni
Page Selup B $ark the pant at wheh Gne page tnds £ Arrange
1 sndiht nest page begine d

TR
Coburme
nughe ate that the 1 tolloawty the oo
sk =# begin m the nét cphum

Text Wrapping
Sepanate 10t dround i jtit: cn adh
pagen sah as caption et from gadh et

Section L pSevtion Breaks

Breaks area
| Mext Page Neat Page command

Intert 3 ecticn breast acd dart the nis

o RVICE, FRIENDLY

nzen 8 Lo ceeak end et the e
zechion on e weme g

Luen Page
‘nset 3 delsn hreak angstatthe ne s
sctior 50 the neat 4.ep-numsered cd3e T z .

Qdd Page
Ingart 1 tectnon brass and Jtut the pew o N -
sechion gn the et 4-1% pumberad page insertion poant

Figure 4-20

2

o Click Next Page in the Section Breaks area of the Insert Page and Section Breaks gallery to insert a next page section
break in the document at the location of the insertion point. If necessary, scroll so that your screen matches
Figure 4-21.

T v YLine Humbers o break
(] mns - - section brea! notation
- . hen, + Lihgh e

st Hyphension | is a formatting mark,

Page Setup . Py eagh g ey . which does not prlm

 (ARE-FOR-YOUR-PETS! |

{
|
k|

break between )
| pages 1and 2

— paragraph formatting
| insertion point on page 2 ! / 4——=— carrled forward from

G

|_ in section 2

previous page

Figure 4-21
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To DELETE A SeCTION BREAK

Word stores all section formatting in the section break. If you wanted to delete a
section break and all associated section formatting, you would perform the following tasks.

1. Select the section break notation by dragging through it.

2. Right-click the selection to display a mini toolbar or shortcut menu and then
click Cut on the mini toolbar or shortcut menu to delete the selection.

1. Position the insertion point immediately to the left or right of the section break

notation.

2. Press the DELETE key to delete a section break to the right of the insertion point
or press the BACKSPACE key to delete a section break to the left of the insertion

point.

To Clear Formatting

or

associated with a section,
double-chick the section
break notation, or dick

the Page Setup Dialog Box
Launcher {Layout tab | Page
Setup group} to display the
Page Setup dialog box. You
can change margtn settings
and page orientation for a
section iry the Margins sheet,
To change paper sizes for a
section, click the Paper tab
(Page Setup dhalog box)

The Layout tab {Page Setup
dialog box) allows you to
change header and footer
specifications and vertical
alignmentt for the section.
To add a border to a section,

<t
o
BTW 3
Sections O
To see the formatting 2
gl
E
QO
=

When you create a section break, Word carries forward any formatting at the

dlick'the Borders button in the
Layout sheet.

location of the insertion point to the next section. Thus, the current paragraph is
formatted the same as the last line of the title page. In this project, the paragraphs
and characters on the second page should be returned to the Normal style. Thus, the

following step clears formatting.

o Display the Home tab. With the insertion point positioned on the paragraph mark on
the second page, click the ‘Clear All Formatting’ button (Home tab | Font group) to
apply the Normal style to the location of the insertion point (shown in Figure 4-22).

To Insert a Word Document in

an Open Document

| 2 ENSERT EXISTING DOCUMENT | 3 CREATE HEADER & FOOTER

4 EDIT & FORMAT LISTS 5 EDIT & FORMAT TABLES l § CREATE WATERMARK

The next step is to insert the draft of the sales proposal at the top of the second page of the document.
Why? You will modify a draft of the body of the proposal, which is located on the Data Files. Please contact your instructor
for information about accessing the Data Files. The following steps insert an existing Word document in an open

document.

# Be sure the insertion point is
positioned on the paragraph
mark at the top of page 2,
which is the location where you
want to insert the contents of
the Word document.

¢ Display the Insert tab.

# Click the Object arrow (Insert
tab | Text group) to display the
Object menu (Figure 4-22),

<L |What if | click the Object button
g by mistake?
Click the Cancel button {Object
dialog box) and then repeat this
step.

Insert tab

nCwuhge'

insertion point —————"""
at top of page 2 \u\

| Page Fof 2 twesede "

Blank Page

v b Table Piclures Qnfine Shapes

= Page Break - Pictures =
Pages Tables titusirations

. BrETTENEaEsEEy . - .

Object button (touch
screens may not have a
| separate Object button
and Object arrow)

. i :n-'h.' Q’Sigmiureﬁne * gl H
5. Date & Time Object arrow
iy

[H TetfromFie.. go—] Text from
File' command

A

paragraph containing insertion |
point returned to formats
defined by Normal style

=

N_-E;F’é* i + 15

Figure 4-22
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e | Insert File dialog box
o Click ‘Text from File’ on the Object & .....--': address bar shows location of
. - - « . D. i i
menu to dlsplay the Insert File : « + 00 Data Fles + Module 04 _.fta Files {your path ma;_'_dlﬁer) -
dialog box. Orgne s Newfalde . SR o D footer
: ) £5} Mrcrosatt Werd ~ O Hame Date modiiad T4pe Werence [ Pageta
« Navigate to the location of the i 47 Anim heic D [ seiected ile Jion sicomnvodiZu  comens vesonas

" Apply 4-) Projected Lollege Expeft?H TPk Microzaft P B |-

. c o4 - = - 4 .
3 ThisPC B" b 43 Consder This Yows Turm Deli.. 1570 70105007 Blosgselt ard D
B Desktop \ ']

file to be inserted f

<] Dotuments
b peiens list of fil look
. . . | : I
& Click Animal Clinic Draft to select i ’::" ‘é‘:’#;r::mode;aengi':; on
T M - ures lt.
the file name (Figure 4-23). o ven settings
i Wit (C)
e FECOWERY {©:}
. 2
Fange
I Range...
File name: | Anirnal Clanic Draft - Alwudooemu(‘,_doo:"?l":{

©

¢ Click the Insert button (Insert
File dialog box) to insert the file,

Animal Clinic Draft, in the open 3‘;:::: = [3 L4 E‘Z‘;’“" & sione w3 %m-:«k BN
document at the location of the s e P e Ships s Blyhd - SRR Ot retrence ™™ Page s
insertion point. i TR P e e R —— e
<« |Where is the insertion point now? E
g When you insert a file in an open : [PUR-PRACTICES
document, Word positions the 3 We-know-yourlove-your-pets.-When-they-need-medical-attention, you-can-
insertion point at the end of the : us.-Dover-Park-Animal-Clinic-offers-full-service-care,-24-hours-a-day,-365-da
inserted document. ; types-of-animals:-birds,cats,-dogs,-and-rabbits.-4]

® Press SHIFT+F5 to position the
insertion point on line 1 of page 2,
which was its location prior to
inserting the new Word document
(Figure 4-24).

Accredited-by-the-American-Veterinary-Group,-Dover-Park-Animal-Clinic
care, surgery,-and-sanitation.-Our-staff-is-dedicated-to-providing-your-pet-
-state-of-the-art-medical: u-are-invited-to-tour-our

e - Lab-and-Pharmacy:-Comprehensive-on-site-lab, medicated-foods,-a
insertion point |* Preventative:-Flea,-heartworm,-and tick-prevention;vaccinationsf|
The keyboard shortcut, SHIFT+ES, - on page 2 o .. Boarding:-Large-indoor/outdoor-pens-with-heated-floors-and-frequ

positions the insertion point at o - Disease-Management:-Allergies,-arthritis, cancer,-diabetes,-and-thy|
your last editing location. Word " e e .. = =

Pegelold  Fawwds LR
remembers your last three editing i
locations, which means you can Figure 4-24
press this keyboard shortcut
repeatedly to return to one of your three most recent editing locations

Q&A

What is the purpose of SHIFT+F5? -]

What if my keyboard does not have function keys?
scroll to display the top of page 2 in the document window.

Other Ways

1. Click Object button {Insert tab | Text group), click 'Create from File’ tab {Object dialog box), click Browse button, locate file, click Insert button
{Browse dialog box), click OK button {Object dialog box}

2 a

e 2 2 @ & @8 8
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2 INSERT EXIFIING DOCUMENT | 3 CREATE HEADER & FOOTER

}QPrint Specific Pages in a Document 4 £01T £ FORMAT Usts | 5 conT 4 FORMAT TABLES | & GREATE WATERMARK

The folldgving steps print a hard copy of only the body of the proposal, that is, pages 2 and 3. Why? You would

he title page is the first page of the proposal. The body of the proposal/;y%ns the second and third pages.
contents of the body of the proposal before you begin modifying it. /

e Click File on thg ribbon to open the Backstage view and then click the Pri}ﬁ tab in the Backstage view to display the
Print gallery.

» Verify that the printgr listed on the Printer Status button will print a I:\)(rd copy of the document. If necessary, click
the Printer Status button to display a list of available printer options &nd then click the desired printer to change
the selected printer.

* Type 2-3 inthe Pages text box in the Settings area of the Print/gallery (Figure 4-25).

Animal Clighe Sales Proposal - Word -

Y AN VIR

APt
A LT gin g e (T bk oty g ) BESREA, v PN SR SH o i b
ot Part Mol S Sy S wovre e U hears o o BV dops 1 v s e elrteg.

1ipee of avenahy mere, Lo, scg s bba

HFUPLS by P A Wy Gy (7o 3 Mot O apty AR v ) ek
B argey ard cuvsn Dos dol oy ot ;
0 Al A g ot P TG W e T L i T Il L Pt s
AT I G ok br e ISR by T R DAY 3 G MRS e
Apemea eyt dor ) i v otn, s s byl b,

Print

printer name
Printer

& EPSONTI1N78 (WP-4540 Seri...

Ready -
o
Piinter Properties [RPPISCL N
T T e ———
X f o,
Settings Py ana o hefrbompari s it
" e e
Y Custom Print B Sicorwg hurk gt ., 050 Cepmcrmg, cmaed s, i 4 Yo e
(¥ . - + W O, T SRITEC KR 4 TR
Type specifi pages, et e T e e
entered I
Print One Sided %
Only print ¢n ane sida of th.

Cellated
123 1,23 1,23

Portrait Orientalion

Figure 4-25

S¥AP
o

¢ Click the Print button tg/print the inserted draft of the sales proposal (Figure §-26).

« | How would | print pagles from a certain point to the end of a document?
g You would enter thefpage number foliowed by a dash in the Pages text box. For
to the end of the dficument. To print up to a certain page, put the dash first {e g.,

xample, 5- will print from page 5
o will print pages 1 through 5).

Why does my dogliment wrap on different words than Figure 4-267
Differences in whrdwrap may be related to the printer used by your computer.

Why does my gcreen show the document has four pages?
You may hayk an extra blank page at the end of the document. This blank page will be de{eted later in the module.

S P

Word Module 4
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\ each page should

GUR PRACTICE contain a header,

We know you love your pets. n they need medical attention, you can be conlident when you turn to
us, Dover Park Animal Clinlc offefy full-service care, 24 hours a day, 365 days a year, for the ollowing
types of animals: birds, cats, dogs,

rabbits, J /
Accredited by the American VeterinashGroup, Dover Park Animal Clinic meets strict guidelines in patient
care, surgery, and sanitation. Cur staff isgdedicated to providing your pet with the highest quality of care Q

and state-of-the-art medical treatment. Yoy are invited to tour our new facities and to meet with our
staff at any lime. Stop by our office at 203 Niyth Sycamore Street in Dover, or call us at 5558282 focan

appointment. We look forward to serving you your faithful friends S

Services

¢ Lab and Pharmacy: Comprehensive on-site lab) icated foods, and prescriptions
«  Preventative: Flea, heastworm, and tick prevent:
« Boarcing: large indoor foutdoor pens with heated

» Disease Management: Allergics, arthaibs, cancer, dial

; waccnations

5 and frequent playtime
. and thyroid

+  Weliness: Behavioral problem guidance, nutritional coun

ling, and primary care check-ups,
*  Grooming: Bath, clips and cuts, coat conditioning, dental ca
+  Medical: Cardiclogy, dermatclogy, endocrinalogy, radiology
should be e Surgical: Microchip implants, neutering/spaying, and orth

p

I

page3 |

B
@
&
@
@
@
D
@
3
@
@
@

picture
bullets i
page break
should not ———
be here _"
5 Sarmgle FEes
Well visits
Microchip 540 540 $40
implant
Q\ N N/A 585 5200 $100
.l S $160 5350 5125
™ Grooming 520 $60 N/A
| 4<- {midsize)
Nail trim 7 510 $15
T %_ Flea bath N/A $15 515 N/A
Boarding (per 320 520 520
day)
/ Facdity
ould be here
' OURTEAM s -
tables to be
Daver Park Animal Clinic has been operational since 2002. Our staff of expel veterinarians and skilled edited and
suppart staff have the background 1o ensure your pet receives the best possitig care. Their experience formatted
and dedication is outlined in the table that follows.
TT=TT
P PR
Wit ekt
Dr. Lana Canaan
.";_Z:' Or. Raul Ramos
| Latisha Adams
: | Max Henreich
Cam lyn
Teresa MeGill T, W, Th, 8a
leo Moretti M, T.Th,F E]
| George Peterson M, W, F
. Dawn Niw M, T, W, F 2
Y ] Ed Va_nW:ij!\ T, W, Th, 5a
1 each page
| should contain
a footer with a
page number
Figure 4-26
| Other Ways

1. Press CTRL+P; press ENTER
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What elements should the body of a sales proposal contain?
Be sure to include basic elements in your sales proposals:

|
®

Word Module 4

¢ Include an introduction, body, and conclusion. The introduction could contain the subject, purpose, statement of
problem, need, background, or scope. The body may include costs, benefits, supporting documentation, available or required
facilities, feasibility, methods, timetable, materials, or equipment. The conclusion summarizes key points or requests an action.

CONSIDER THIS

« Use headers and footers. Headers and footers help to identify every page. A page number should be in either the
header or footer. If the sales proposal should become disassembled, the reader can use the page numbers in the headers or
footers to determine the order and pieces of your proposal.

¥ You must hove A show|iude \o\mov\ on 4o See the

2 INSEAT EXISTING DOCUMENT | 3 CREATE HEADER & FOOTER

To Delet_e_ d Page Brea k ? Me’ b 'P_ﬁ&:lé"‘_ | 4EDITSFORMAT USTS 5 EDIF & FQRMAT TARLES | 6 CREATE WATEAMARK

After reviewing the draft in Figure 426, you notice it contains a page break below the bulleted list. The
following steps delete a page break. Why? This page break below the bulleted list should not be in the proposal.
o e W, e PO TR e
» . Grooming:-Bath,clips-and-cuts, coat-conditioning,dental-
» + Medical:-Cardiology,-dermatology,-endocrinology,-radiolog]

o o § Sondooy Ao P i-neutering/spaying, - and-orthul
B I W - A- - = - Hpd

e Scroll to display the page break notation.
® To select the page break notation, double-ciick
it (Figure 4-27).

e l .........
¢ Press the DELETE key to remove the page break L fea 232&9“ b \
from the document. e ——— .,.._]

e -

Figure 4-27
Other Ways
1. With page break notation selected, click Cut button 2. With page break notation selected, 3. With the insertion point to the left or
{Home tab | Clipboard group) right-click selection and then click Cut right of the page break notation, press
on mini toolbar or shortcut menu DELETE or BACKSPACE, respectively

To Apply Heading Styles

Word has many built-in, or predefined, styles that you can use to format text.
Three of the Styles shown in the Styles gallery in Figure 4-28 are for headings:
Heading 1 for the major headings and Heading 2 and Heading 3 for minor headings.
In the Animal Clinic Draft, all headings except for the first two were formatted using
heading styles.

The following steps apply the Heading 1 style to the paragraph containing the
text, OUR PRACTICE, and the Heading 2 style to the paragraph containing the text,
Services.

o Position the insertion point in the paragraph to be formatted to the Heading 1 style,
in this case, the first line on the second page with the text, OUR PRACTICE.

e Click Heading 1 in the Style gallery (Home tab | Styles group) to apply the selected
style to the paragraph containing the insertion point.

< | Why did a square appear on the screen near the left edge of the paragraph formatted
g.with the Heading 1 style?
| The square is a nonprinting character, like the paragraph mark, that indicates text to
Iits right has a special paragraph format applied to it

9 Position the insertion point in the paragraph to be formatted to the Heading 2 style,
in this case, the line above the bulleted list with the text, Services.
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o Click Heading 2 in the Style gallery (Home tab | Styles group) to apply the selected
style to the paragraph containing the insertion point (Figure 4-28).

Bds Heading 1 style Heading 2 style

2
il
i B
-
ko
>
I
i

Etne SEAE 80 aapocedd Assbcenx AaBbC ‘ECcIAaachD A3
Ty -me = A-¥.4- == 5 L - “Uwmensi  MoSpeong  Heading) | He

TEE

paragraph formatted ng ! | Heading i1
ta Heading 1 style Font s Patagiaph 3 €1
TR R ek i ’ 3 ¥
’ Style gallery
* OUR-PRACTICES -
Styles group
: We-know-you-love-your-pets.-When-they-need-medical-attention,you-can-be-confident-whd

| B us,-Dover-Park-Animal-Clinic-offers-full-service-care, 24-hours-a-day, 365-days-a-year,-for the
' nanprinting character |Wpes-of-am'mals:-blrds,-cats,-dogs,-and rabbits.-§
indizates text to its right
 has aspecial paragraph | p ¢ eredited-by-the-American-Veterinary Group, Dover-Park-Animal-Clinic-meets strict-guideli

T care, surgery,-and-sanitation.-Our-staff-is-dedicated-to-providing-your-pet-with-the-highest-q
. +  and-state-of-the-art-medical treatment.-You-are-invited-to-tour-our-new-facilities-and-to-mee|
paragraph formatted . ) "
| ta Heading 2 style staff-at-any-time. Stop-by-our-office-at-203-North-Sycamore-Street-in-Dover, or-call-us-at-555
- appointment. We-look forward-to-serving-you-and-your-faithful-friends.1]

-
Sorviesg—Limerionein

e » Lab-and-Pharmacy:-Comprehensive-on-site-lab,-medicated-foods, and-prescriptions
» + Preventative:-Flea, heartworm, and tick-prevention;vaccinations

L_...-«f"“ ——Bgarding:Larse——""—=aifhheatedfloe—""" = ——imef_
Figure 4-28

BREaB8 B8 E

To Change Spacing before and after a Paragraph

The next step is to adjust spacing above and below the current paragraph, that is,
the heading above the bulleted list. This paragraph is formatted using the Heading 2
style, which places no space above the paragraph and 8 points below the paragraph.
You would like this paragraph, and all other paragraphs formatted using the Heading 2
style, to have 12 points of space above them and 6 points of space below them. Thus,
the following steps adjust the spacing before and after a paragraph.

a8 aa

o Display the Layout tab. Position the insertion point as shown in Figure 4-29. Click the
Spacing Before up arrow {Layout tab | Paragraph group) as many times as necessary
5o that 12 pt is displayed in the Spacing Before box (or, if using touch, tap the Spacing
Before box (Layout tab | Paragraph group) and then type 12 to change the spacing
above the paragraph).

a a

e If necessary, click the Spacing After up arrow (Layout tab | Paragraph group) so that
6 pt is displayed in the Spacing After box (or, if using touch, tap the Spacing After box
(Layout tab | Paragraph group) and then type 6 to change the spacing below the
paragraph}.

|
2 A

B

To Update a Style to Match a Selection

6

You want all paragraphs formatted in the Heading 2 style in the proposal to use
this adjusted spacing. Thus, the following steps update the Heading 2 style so that this
adjusted spacing is applied to all Heading 2 paragraphs in the document.

B &

0 If necessary, position the insertion point in the paragraph containing the style to be
updated.

)
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e Display the Home tab. Right-click Heading 2 in the Styles gallery (Home tab | Styles
group) to display a shortcut menu (Figure 4-29).

Click ‘Update Heading 2 to Match Selection’ on the shortcut menu to update the
Heading 2 style to reflect the settings at the location of the insertion point.

Heading 2 style right-clicked

menu

: Cobilign¢ - (10 - K & Aa- B -5 f AaBbCc [AsBbee| sazbced ADH assncer
Paste o mstbeinter BA T N ke A . } 2| Headings  Tte Subile SugEm_ 5
i i j "Update Heading2 | By U ate Hemting § 1o Kt Eriectios i
e = ’ = | to Match selection’ & Hoid =
L RO - [ 1 ) 1
T ; command s e e
*OUR-PRACTICEY 1 11 Ragavr.

| Bz from e Judary

We-know-you-tove-your-pets.-W /uu-can-be-c 48 fiabary ve Sk Aope Tocshe:
r

us.-Dover-Park-Animal-Clinic-offe -365-days-a-year, - for-the-following:
types-of-animals:-birds,-cats,-do

I-Clinic-meets-strict-guidelines-in-patient-
+your-pet-with-the-highest-quality-of care:
ur-new-facilities-and-to-meet-with-our-

-in-Dover, or-call-us-at-555-8282-for-an-
ds. ¢

Accredited-by-the-American-Vet
care,-surgery,-and-sanitation.-O
and-state-of-the-art-medical tr

| space increased

!l above paragraph |

space increased
below paragraph

foods,-and-prescriptions§

+ -+ Preventative:-Flea,-hea inationsY]
® - Boarding:-Large-indcor/ -and-frequent-playtimeq]
. & + Disease-Management:-A es,-and-thyroidq]
Pagezof 3. 394 words i}
Figure 4-29

Creating Headers and Footers

A header is text that prints at the top of each page in the document. A footer is text
that prints at the bottom of each page. In this proposal, you want the header and
footer to appear on each page after the title page; that is, you do not want the header
and footer on the title page. Recall that the title page is in a separate section from the
rest of the sales proposal. Thus, the header and footer should not be in section 1, but
they should be in section 2. The steps in the following sections explain how to create a
header and footer in section 2 only.

To Insert a Formatted Header Different ,
from the Previous Header

BTW

Headers and Footers
If a portion of a header or
footer does not print, it

may be in a nonprintable
area, Check the printer user
instructions to see how close
the printer can print to the
edge of the paper. Then, click
the Page Setup Dialog Box
Launcher (Layout tab | Page
Setup group}, click the Layout
tab {(Page Setup dialog box),
adjust the From edge text box
to a value that is larger than
the printer's minimum margin
setting, click the CK button,
and then print the document
again.

| 3 CREATE HEADER & FOOTER

4 EOIT & FORMAT LISTS | S EDIT & FORMAT TABLES | 6 CREATE WATERMARK

Word provides several built-in preformatted header designs for you to insert in documents. The following
steps insert a formatted header in section 2 of the sales proposal that is different from the previous header. Why?
You do not want the beader to appear on the title page, so you will instruct Word to not place the beader in the previous

section. Recall that the title page is in section 1 and the body of the proposal is in section 2.

» Display the Insert tab. Click the *Add a Header’ button {Insert tab | Header & Footer group) and then click Edit

Header in the Header gallery to switch to the header for section 2.

 If the ‘Link to Previous’ button {(Header & Footer Tools Design tab | Navigation group) is selected, dlick it to deselect
the button because you do not want the header in this section to be copied to the previous section (that is, the

header should not be on the title page).

<
L
=]
T
3]
=
T
3
2
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ek ' Differeny Fipst yoge!

# Click the ‘Add a
Header’ button

Add a Header
8 2allery contains list

Header 8 Footer Tools Design
tab automatically appears

[ -

(Header & Footer 2, ‘-~. Eﬂ |.. & 1 . of I?.uilt in he.ad.ers V‘;ﬂ«m Fost Page | because you are editing header
i m' p" = ;w'&;* ;"'“ Mﬂ i Pncs. Difeient Odd B EvenPages | "+ Footesfrom Botiomy 057 1
Tools Design tab | _ e g e T g e % Link 1o Porrin. | . Shaw Documant Tosk [<] tosert Agamen Tab
Header & Footer n : e Osteny Pastion
roup) to display the *Add a Header’ . ‘Link to Previcus’ button is not selected,
9 p) play butten | \ which means headers and footers
Add a Header gallery added to this section will not be added |
(Figure 4_30) I_tcn previous section
HE Blank {Theee Columni}
‘/ \ -
"\8) Experiment it et s «——— section 2 header |——4- @
= Scroll through
. . . Auntin
the list of built-in s @
headers to see the i _— o . . .
. ] 0 '.‘ ) v ‘l n\ I Ha B - C i +!
vanety of available 'r_;.Je_ts Mhenthayq r.-.‘e edicai-attention,you-can-be-confident w oy
formatted header T I Banded header design ] Zlini¢-offers-full-service-care, 24 hours-a-day, 365-days-a-year,-for-tha Sy
desi -cats,-dogs.-and-rabbits. )
asigns.
rican-Veterinary-Group, Dover-Park-Animal-Clinic-meets-strict-guideli
B More Headen buagm Clsn.com , :ation.-Qurstaff-is-dedicated to-providing-your-pet-with-the-highest-q
00 Header Lizal-treatment.-You-are-dnvited-to-tour-our-new-facilittes-and-to-m
T Bemoe Header ———7| ::Er:a:e:,g;;:;??;:‘: Ir-ofﬁce at 203 North-Sycarmore Street-in Dover,-or-cali-us-at-55 @
by P =y P ard-to-serving+you-andyour faithful friends. §
':_'?_'“'_’ L LT T ] \

Figure 4-30

(2

¢ if necessary, scroll to T 5 o¢ ——— SRR, e
and then click the  section 2 content control |

Banded header design || panded header | ___,
in the Add a Header [ desion inserted

gallery to insert the ;
formatted headerin |-

: section 2 |
the header of section | {50

2, which contains ________———\5'—1-480&_'1!_.]_{_!___:' your-pets.AWhog

a content control - i
{Figure 4-31). Figure 4-31

[Heaer sedmn?. |

(e
AT PRACTICES

22888

ltentson,-vou-cawbe-c [

What is a content control?

A content control is an object that contains sample text or instructions for filling n texs
| and graphics.

(3

e Click the content
control, [DOCUMENT
TITLE], to select

Q&A

&

‘Go to Footer’
el button Header & Footer

P . o WA L5 L = Tools Design tab
D - l“ yaf @ ‘[_é.l [ | oy Haades ik L™

N ! LA i = L4 ; 2 + Next sgef Foates bom Bottiy ='d.l:
it and then type Hasde lrocide qu, B bt -.l:mnlu ;::;k Pictures cl... i ’c:::' ik  Teiim Dol AT P i Aligpemet T £y
Dover Park Hrader & Foaler ¢ imert _ Ryngatian Colang Pasrtion

. . RN, P . 3 - 3 L B
Animal Clinic : & g €
s Header &
in the content control Footer group
(Figure 4-32) text entered in

content control

&

[ o

1

EFNES

Figure 4-32 @
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Netd 10 eymoe?

<t
2z
=
i)
o)
g How would | delete a header? =
¥ T
0 s
Other Ways
1. Click 'Add a Header’ button {Insert tab | Header & Footer 2. Click *Explore Quick Parts’ button {Insert tab | Text group), click ‘Building
group), select desired header in list Blocks Organizer’ on Quick Parts menu, select desired header (Building
Blocks Organizer dialog box}, click Insert button
To Insert a Formatted Footer BTW
Page Numbers
The next step is to insert the footer. Word provides the same built-in It Word displays {Pace} instead

, . . of the actual page number,
preformatted footer designs as header designs. The footer design that corresponds to press AUT--Fa to turn off field

the header just inserted contains a centered page number. The following steps inserta  codes. If Word prints {pace)

formatted footer in section 2 of the sales proposal that corresponds to the header just ~ instead of the page number,
inserted open the Backstage view, click
. the Options tab to display

the Word Options dialog box,
o Click the ‘Go to Footer’ button (shown in Figure 4-32) (Header & Footer Tools Design click Advanced in the left

tab | Navigation group) to display the footer for section 2. pane (Word Options dialog
box), scroll to the Prnt area,

e If the ‘Link to Previous’ button (Header & Footer Tools Design tab | Navigation group) ~ remove the check mark from
is selected, click it to deselect the button because you do not want the footer in this g;ihz:":a‘:'i‘:,cgi’ii'g“fad J

section to be copied to the previous section (that is, the footer should not be on the then click the OK buttot; ~an
N 1 .

tide page)- CAAGK. * DAFeRent Fiast page

Click the "Add a Footer' button (shown in Figure 4-32) (Header & Footer Tools Design

tab | Header & Footer group) to display the Add a Footer gallery.

Click the Banded footer design to insert the formatted footer in the footer of section 2
(shown in Figure 4-33).

o 0

Why is the page number a 2?
The page number is 2 because, by default, Word begins numbering pages from the
beginning of the document.

<
o
o

To Format Page Numbers to Start 5 emeare weABe & So0ren
at a D iffe re nt N u mber 4 EDIT & FORMAT LISTS 5 EDIT & FORMAT TABLES | 6 CREATE WATERMARK

On the page after the title page in the proposal, you want to begin numbering with a number 1, instead of
a 2 as shown in Figure 4-33. Why? Word begins numbering pages from the beginning of the document, and you want it
to begin numbering from the first page of the body of the proposal. Thus, you need to instruct Word to begin numbering the
pages in section 2 with the number 1. The following steps format the page numbers so that they start at a different
number.
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o

¢ Click the ‘Add Page
Numbers' button
(Header & Footer

= = —
| Header & Footer
d Tools Design tab

 ‘Add Page in
Hemt W Numbers’ button
1-::: 1 ..k]: i

Hesder Foater | Page | Dite& Document Quick

Add Page | Prevoun Diffecant Fust Page S Hesdertrom Top A8
Numbess menu , Hext

Difletens Odd & Even Pages  +Footer from Bottom: 0.5°

Tools Design tab | e NRDSE. Tene lo- P e ot 7 LinktoPrevious -+ $how Document Fen [} tnsent Algrueneen Tab o
Header & Footer Hesperk® 3 Lepct? > g catienn Postion

L A3 eememot . ! ] - c -5

group) to display the
Add Page Numbers

. e ‘Format Page

menu (Figure 4-33). D R e ——
ook :1 2 ALY pEravy 33
Header & |
Footer group . i

- section 2 footer

Factir Sectmn d
8anded footer age 1
design inserted 1 2u?nber is 2
il
Fage dal i FilosE
Figure 4-33 (i
fiil

e Page Number

. Format dialog box

e Click ‘Format Page Numbers' on :
the Add Page Numbers menu to 1
display the Page Number Format Page Humbes Format

% 0

|
Number |

dialog box. tonder tareats 1,23 “a— format
[ inctuge chapter pumber arrow
= Click Start at in the Page tn tor | rostg | o
numbering area {Page Number 3 S
Format dialog box), which displays i‘:{,‘uﬂ‘ - Page
a 1 by default as the starting page button Comutt trom prewovt secvon | NUTTIDEIING acea |
number (Figure 4-34). Gnt _1&“'“" '®
number 1, by default, Caniel

Can | also change the look of the
page number?

displays as the starting
page number in Start
at box

8 Sechinn

OK button

Figure 4-34

‘Close Header
and Footer
button

(3

» Click the OK button to change the
starting page number for section 2
to the number 1 (Figure 4—35).

Header & Footer |,
Tools Design tab [

4 Previous. Ditesens Farst Fage .t Hesder from Top 057

) cm__k et » Next DiEtesert Odd & Even Pages .+ Foctet fuam Bottome 0.5
# Click the 'Close Header and - e Putures Header “cir = brkioPievous S ShowDocument Tt R ,.
lerient lemegaion ey Close grou,
Footer' button (Header & Footer s I A A e e e o oup

Tools Design tab | Close group) to :
by
close the header and footer. cp;ag:gne‘:i":oear1 g

3

s

Figure 4-35
Other Ways

1. Click ‘Add Page Numbers' button {Insert tab | Header & Footer group), click ‘Format Page Numbers' on Add Page Numbers menu, set page
formats (Page Number Farmat dialog box), click OK button
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Editing and Formatting Lists

The finished sales proposal in this module has two lists: a bulleted list and a numbered
list (shown in Figures 4-1b and 4-1c at the beginning of this module). The bulleted
list is in alphabetical (sorted) order, the first word of each list item is emphasized, and
the bullets are graphical instead of simple round dots. The numbered list has multiple
levels for each numbered item. The following sections illustrate steps used to edit and
format the lists in the proposal:

1. Sorta list of paragraphs.

2. Format text in the first list item and then copy the format to text in each of the
remaining list items.

3. Customize bullets in a list of paragraphs.
4. Create a multilevel numbered list,

To Sort Paragraphs

4 EQIT & FORMAT LISTS | 3 EDIT & FORMAT TABLES | 6 CRIEEATE WATERMARNK

The next step is to alphabetize the paragraphs in the bulleted list. Why? It is easier for readers to locate
information in lists that are in alphabetical order. In Word, you can arrange paragraphs in alphabetic, numeric, or
date order based on the first character in each paragraph. Ordering characters in this manner is called sorting.

The following steps sort paragraphs.

e if necessary, scroll
to display the
paragraphs to be

= Home tab

S Bl iCalbriBedy) 11+ A W

sorted. L By , &= ""f_ﬁf’; 3 aasnceoc assbone AaBbC nasbce asoced A
. ¥ rammterte 8 T L cmx xR ¥oa-E==m 5 L. | tNomu NoSping Hesding! Hesding 2 rieading 3
# Drag through the | owbon = ont . bara 5
g g L LB : T TS Fe - | Sort Text o et .mmA - rae
paragraphs to be : ! dialog box [~
sorted, in this case, T « Servicest Son Text r
the bulleted list. i o Soetby / :
@ [+ + Lab-andPharmacy:Cg . N roe g Wesomans - 0
5 ! o B - BN L | O Lestending
» Click the Sort : .. ?revengatlve:-Flea.-!‘_l_é e
button (Home tab | - .a Ma'f!‘!“B"'l{FBé'lhdﬂ'ﬁ g v T r‘m .
P?ragraph group)to  |* po— * - Disease:Managementi .,,, -
display the Sort : to be sorted * + Wellness:-Behavioral =
! : lected e e ]
Text dialog box S bt » + Grooming:-Bath, clips{ vy,
{Figure 4-36). .- Medical::Car_t_:lloIogy_,'-d [ Heacus cow @ No header 0w
S e » - Surgical:-Microchipiiny | ssten--
< at does bR Tt
@ ascending mean? i | « Sample-Feesy
(=4

Ascending means to
|sort in alphabetic,
| nurneric, or earliest- : Initial-exami
to-latest date order,

LY PN | IO P sson 545“

S600

$551

4551

$454 $a0u

9 ;Mtlofi_ﬁvlaﬂnwdl [i7]
& Click the OK button Figure 4-36
{Sort Text dialog
box} to instruct Word to alphabetize the selected paragraphs (shown in Figure 4-37).
= Click anywhere to remove the selection from the text.

Word Module 4
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To Apply a Style Using the Mini Toolbar

The text up to the colon in each list item is to be formatted in italic with the
color purple. Although you could apply formatting using buttons in the Font group on
the ribbon, it is more efficient to use the Intense Emphasis style. If you use a style and
decide at a later time that you want to modify the formatting, you simply medify the

. style and Word will apply the changes to all text formatted with that style. Thus, the
following steps format text using a style.

o Select the text to be formatted (in this case, the text, Boarding, in the first list item).

e Click the Styles button on the mini toolbar to display the Styles gallery (Figure 4-37).

9 Click Intense Emphasis in the Styles gallery to apply the selected style to the selected
text,

«  Could | use the Styles gallery on the Home tab instead of the mini toolbar?
o Yes.

—_—

._n-—--—-n-.-..,._____“_'
—_ —_—

——— s B
b= ini toolbar rant T Faagraph Ses
R Rl ' b Styles buttan §- roruirni T, Rt

S Bt
B I UW-A-iE-| - 4 yles gallery

» - Boarding:-Large-indoor/on asbceoe asbcens AaBLC
* . Disedsg-Management:-All

| raading

Aa B

N Groomin'- LF - AyiaCel
text selected | "oy ¢ ttate
BTW paragraphs ® -+ Lab-and-Pha
sorted . _ ApBBCCOH Aeihiiln AaBbCX
Format Painter » - Medical:-Cardiology, dern ... ... i

If you also want to copy
paragraph formatting,

such as alignment and line
spacing, select the paragraph
mark at the end of the
paragraph prior to clicking
the Format Painter button
{(Home tab | Clipboard
group). If you want 1o copy
only character formatting,
such as fonts and font sizes,
do not indude the paragraph
mark in your selected text.

» - Preventative:-Flea, heartv ., -
» - Surgicali-Microchipimplal = ©
L- - Wellness:-Behavioral-prob sseecet

" List Pars

AaBECIIEN AABBL DY

Aq Lseste bty

Rp  LharFermatting

« Sample-Feesq

Initial-examit

Figure 4-37

Intense
Emphasis to
be selected

aatbce and-frequent-playtimef)
Hedoa? ¢ Land-thyroidd)
428bCD care,-and-nail-trimd]
Sukthe Em...
i-foods,-and-prescriptions§

AaBbCeih . d

- 'BY.and-rehabilitationq)
ansbcen Nationsy

sapedic-surgeryfl

ing,-and-primary-care-chec

4551

i
To Use the Format Painter Button

4 EDIT & FORMAT LISTS I S EDIT & FORMAT TABLES I 6 CREATE WATERMARK

The first words in each of the remaining list items is to be formatted the same as the first words in the
first list item. Why? You would like the lists to be formatted consistently. Instead of selecting the text in each list item
one at a time and then formatting it, you will copy the format from the first word to the remaining words. The

following steps copy formatting.

» Position the insertion point in the text that contains the formatting you wish to copy (the text, Boarding, in this

case).

o Double-click the Format Painter button (Home tab | Clipboard group) to turn on the format painter. ( ‘0 OKS ‘\\Q

< | Why double-click the Format Painter button?

0 paint Yeus

g' To copy formats to only one other location, click the Format Painter button (Home tab | Clipboard group) once. i
t you want to copy formatting to multiple locations, however, double-click the Format Painter button so that the

format painter remains active until you turn it off.
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¢ Move the pointer to where you
want to copy the formatting (the
text, Disease Management, in this

Word Maodule 4

Celbuibodyi - 11+ A A M- M IEVIZ.NE. mIE
case) and notice that the format e i) S e AP EFEE e B-S- | homal Helesmy Hesng!
painter is active (Figure 4-38). v s Format Painter - Srpeoh 5
L TT - button : T 1 f a
< How can i tell if the format

D
]

= o Servicesy S :
g painter is active? : ;'r"l:::ﬂ'd .
The pointer has a paintbrush . ® = Boordjng:-large-indoor/outdoor-pens-with-heated-fioors-and-freq

attached to it when the format p— s -2Disease-Management:-Allergies, -arthritis,cancer, diabetes, -and-t
— painter is active. attached to = -+ Grooming:-Bath, -clips-and-cuts,coat-conditioning, dental-care, -and-
e : ?;',?,;i’;:?,:::ﬁ: ¢ -+ Lab-and-Pharmacy:-Comprehensive-on-site-tab,-medicated-foods, 2
actize * + Medical:-Cardioiogy, dermatology,-endocrinology, radiology,-and-re

e

® Select the text in the next list item
(the text, Disease Management,
in this case) to paste the copied
format to the selected text.

LR Preventative:-FIea,-heartwon'n,-and-tick-preventlon;-vaccinations]
. Surgical:-Microchlp-implants,-neutering/spaving,-and-orthopedic-s
L Wellness:-BehavioraI-problem-guidance,-nutritional-counseling,-an

g

aS>ample-Fees
<€ What if the Format Painter button P !

¥ B G
g.-no longer is selected? / V

Repeat Step 1. Figure 4-38

£

3]

» Repeat Step 2 for the remaining
the list items, selecting text up to
the colon in Grooming, Lab and
Pharmacy, Medical, Preventative,

Surgical, and Wellness. e Format ainter | % o I A
¢ Click the Format Painter button Y . _""“°1I"
(Home tab | Clipboard group) o ervices
i Clipboard
to turn off the format painter group * + Boarding:-Large-indoor/outdoor-pens-with-heated-floors-and-freq

(Flgure 4-39). 3 "o - Dr‘sease-Management:-Al!ergies,-arthritis,tancer,-diabetes,-and-
.o Groommg:-Bath,-clips-and-cuts,-coat-oonditioning,dental-care.-and
:grtr::ll ts:;als;:td ® - Lab-and Pharmacy:-Comprehensive-on-site-fab,-medicated-foods, -af
of colon in * + Medical:-Cardiology,-dermatology,-endocrinology, radiology,and-re
::f:g'::gﬁmd * - Preventative:-Flea,-heartworm,-and-tick-prevention; vaccinationsy
* ~ Surgical»Microchipimplants,-neutering/spaying,-and-orthopedic-

. We!l/iess:-BehavioraI-problem-guidance,-nutritional-oounseling,- !

« Sarnple-Feesy

Figure 4-39

. . . !
To customlze Bu I'ets ln a Ll st 4 EQIT & FORMAT LISTS S EDIT & FORMAT TABLES | 6 CREATE WATERMARK

The bulleted list in the sales proposal draft uses default bullet characters, that is, the dot symbol. The
following steps change the bullets in a list from the default to picture bullets. Why? You want to use a more visually
appealing bullet that looks like a veterinary caduceus. Word refers to graphical bullets as picture bullets.

- e W W W W W W W TS
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e Select all the
paragraphs in the
bulleted list.

e Click the Bullets
arrow {(Home tab |
Paragraph group) to
display the Bullets
gallery (Figure 4-40).

« | Can | select any of

3 the builet characters
in the Bultet Library
area of the Bullets
gallery?

12

| Home tab

¥ ow
12 Copy
¥ Farrnat Faenet

U'-'V‘-\..J.‘L.._n

s
137

s Bullets

Bullets arrow
button | B

TGt A ERS L. B ﬁ‘ Bulhisgallery e samscen DK

i Buhetleraryarea g i Ly i lemung Heshing! Hesding?  Hestng Taie

Fastt Y * ) = & 0:0 o
a a . 1 1
= Servicesq r v
i e s
(e« Boording-Large -floors-and-frequent-playtimey
* + Disease-Manogi ‘ diabetes,-and-thyroidy
e+ Grooming-Bath ‘Define New re,-and-nail-trimg

all paragraphs
in bulleted list
selected

Bullet’ command

o + Lgh-and-Pharmop.cormpreimiaivesu-ai ‘oods,-and-prescriptionsq
» - Medicak-Cardiology,-dermatology,-endocrinology, radiology,-and-rehabilitationy

i 4

e

« - Preventative:-Flea, heartworm,-and-tick-prevention;-vaccinationsq
L Surgr'ca?:-Microchlp-implants,-nemeringlspaying,-and-orthopedic-surgem
Lo~ Wellness-Behavioral-problem-guidance,-nutritional-counseling,-and-primary-care-check

defautt buttet €5
characters

Figure 4-40

o Click ‘Define New Bullet’ in the Bullets gallery to display the Define New Bullet dialog box.

» Click the Picture
button (Define New
Bullet dialog box)
to display the Insert
Pictures dialog box.

» Type veterinary
caduceus inthe
search box (lnsert
Pictures dialog
box) and then click
the Search button
to display a list
of pictures that
matches the entered
search text.

» Scroll through the
list of pictures to

locate the one shown

in Figure 4-41, or

a similar image.

{If necessary, click
the ‘Show all web
results’ button to
display more images

Define
New Bullet
dialog box

|
f
I
L

that match the search text.)

What if | cannot locate the image in Figure 4-41, and | woulc

ol
o

Insert

-| Pictures . X 31
| dialog b bo \ aagbCete Asecrnr AaBbCt AaBbCe fasvcen A
v g

oy Fexding ) Fening ) Tare

—

search text
=] entered

i
Picture button
;:

piciure to be
selected for
bullet character

LR Surg:ca*
s - Wellness::,

fomee wl ot 3012

-./ el o treer Loeael

$50u . $55n

*Show all
web results’
button

—

« Sample-leesy|

$55n

i—" ~——_ 541/‘}551—-————\530!\

Figure 4-41

age?
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<t

ALY

=

0 3

¢ Click the desired picture to select it. s

e ———— i e

» Click the Insert button (Insert = ot . ——— = T

Pictures dialog box) to download ’7 frosiad g : ' - é’
the image, close the dialog | = Servicesq|

. —
. box, and show a preview of the \ :annge | I"aa Boarding:-Large-indoor/outdoorpens-with-heated-floors-and-frequent-playti
: . picture | P
selected picture bullet in the

! ) RUlEE % -+ Diseose-Management:-Allergies,-arthritis,-cancer, diabetes, -and-thyroidq
Define New Bullet dialog box. 'F_ ¢+ Grooming:Bath, clips-and-cuts,-coat-conditioning,-dental-care,-and-nail-tri
o - Lob-and Pharmacy:-Comprehensive-on-site-lab, medicatect-foods,.and-prescri
) . % Medicol:-Cardiology, dermatology,-endocrinology, radiclogy,-andrehabilitatio
e CI'CIk the..' ?K button (Dl’:efme New "l—-Preventarr've:-Flea,-heartworm,-and-tick-prevention;-vaccinationsq
Bullet dialog box) to ¢ SOE | % Surgical:-Microchip-implants,-neutering/spaying,-and-orthopedic-surgerv!l

tI’)e bullets in the selected list to H [ %~ Wellness:-Behavioral-problem-guidance,-nutritional-counseling,-and-primary-ca
picture bullets. [
¢ When the Word window is visible | - Sample-Fees]
again, dick in the selected list to
remove the selection e B

(Figure 4-42),

TO create a M u lti Ievel N u m be rEd Li St 4 EDIT & FORMAT LISTS 5 EDIT & FORMAT TABLES & CREATE WATERMARK

"The next step is to create a multilevel numbered list below the Facility heading on the last page of the
sales proposal in this module (shown in Figure 4 - I¢ at the beginning of this module). Why? You would like to list
the team miembers and their hours at the clinic.

A multilevel list is a list that contains several levels of list items, with each lower level displaying a
different numeric, alphabetic, or bullet character. In a multilevel list, the first level is displayed at the left edge
of the list and subsequent levels are indented; that is, the second level is indented below the first, the third level
is indented below the second level, and so on. The list is referred to as a numbered list if the first level contains
numbers or letters and is referred to as a bulleted list if the first level contains a character other than a number
or letter.

For the list in this project, the first level uses numbers (i.e., 1., 2., 3.), the second level uses lowercase
letters (a., b., c.), and the third level uses lowercase Roman numerals (for example, i, ii, iii.). The following steps
create a multilevel numbered list.

* Position the insertion point at CoraBedyl < K K A1e B I 1181 Tosceor =
the location for the multilevel S tomatrioy BT U emn w0 G-W.p. Em=om X ing Heading)  Hewling
numbered list, which in this case e— A e : Sesniie M farrent List | 3
is the blank line below the Facility it . =, ' ‘ * | Multilevel
heading on the last page of the l | ;g;:gﬂ * FIITR L ostery
sales proposal. nsertion 1 =3 Lt Liary

point . .

» Click the Multilevel List button \ \ Facility§ i A
{Home tab | Paragraph group) to ] i
display the Multilevel List gallery I + artcie
(Figure 4-43). * OUR-TEAMY = s:mg '

) Dover-Park-Animal-Clinic-has-be * Fhoncee 1
support-staff-have-the-backgrov i
/ and-dedication-is-outlined-in-the
PR ——— {112 Hem hitherc A= | LT cOmMEnd
I ._ m-Viembers SEETSNETIN Site
L ___1‘-‘-\1__“_“ — e o
Figure 4-43
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2

» Click the Current List format in the Multilevel List gallery to display the current paragraph as a multilevel list item
using the current number format, which in this case is an indented 1 followed by a period.

g
g number format?

tist button (Home tab | Para L L R M L
group) and then select the B S n e epatt)
desired format in the Multil
List gallery, or click Define N
Multilevel List in the Multile L P ——
List galiery (shown in Figure | firstdevel " tacilityd item entered
to define your own format. SEag | e ltem 1. - Clinic-Hours$)
» Type Clinic Hours as a first- " should be a /’ 2-R
level list item and then press the fecond tevel
ENTER key, which automatically T * QUR-TEAMY|
places the next sequential number Dover-Park-Animal-Clinic-has-been-operational since-2002.-Our-staff-of-exp
for the current level at the support-staff-have-the-background-to-ensure-your-pet-receives-the-bestp
beginni)n(g of the next) line (in this and-dedication-is-outlined-in-the-table that-follows.§
case, 2.} (Figure 4-44}.
...--"""_'___‘__ B n _._"""'"--;....___

©

= Press the TAB
key to demote
the current list
item (the 2.) to
the next lower
level, which is
indented below
the higher-level
list item (in this
case, converting
2.t0al).

(4

¢ Type the text
for list item 1-a
as shown in
Figure 4—45 and
then press the
eNTER key, which

What if { wanted a different

You would click the - Multile CabnBeays - 1 - A K Aa- e 2

e

= Facitity¥l

[ converted to | 1.~ Clinic-Hours9)

ﬁ:‘i’:'edr:“e' a. - Monday-through-Friday-~7:00-a.m.-to-7:00-p.m.q
iz b.- Saturday—7:00-a.m.-t0-1:00-p.m.9q text
should be ¢. - Sunday—Closed {except-for-boarding-pickup-from 6:00-p.m.-to-7:00-p.m.}9 entered

promoted to

| first-level list —ed. ~h'|
item, aligned

below number 1

* QUR-TEAMY)

Dover-Park-Animal-ClinLc-has-been-operational-since-2002.-Our-staff-of-expert-veterinarians-and-skilledv
support-staff-have-the-background-to-ensure-your-pet-receiveSvthe-best-possible-care.-Their~experience-
and-dedication-is-outlined-in-the-table-that-follows.q

Figure 4-45

automatically places the next sequential list item for the current level on the next line {in this case, b.).

« Type the text for list item 1-b as shown in Figure 4-45 and then press the ENTER key, which automatically places the
next sequential list item on the next line (in this case, c).

e Type the text for list item 1-c as shown in Figure 4-45 and then press the ENTER key, which automatically places the
next sequential list item on the next line {Figure 4-45).

(5

o Press SHIFT+TAB to promote the current-level list item to a higher-level list item (in this case, converting d. to 2.).

g Can | use buttons on the ribbon instead of pressing TAB or SHIFT+TAB to promote and demote list items?

o

2 A af

-® A N
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¢ Type Contact Information as a first-level list item and then press the ENTER key.

o Press the TAB key to demote clicking Decrease Indent
I button functions the same
the current level list item to a - as pressing SHIFT+TAS in a
lower-level list item (in this case, B multilevel list

CalienBodyl + 11 |

clicking Increase Indent
button functions the

same as pressing TAB in a
3 multilevel list

=
A
=
e
=]
=
e
=]
=

- bCe
converting 3. to a.). P romatpiitn B T U m w G Fohe BEEE e A-Dc | Nemal cNeSpom Hadng! b

¢ Type FPhone: 309-555-8282 e oai
and then press the ENTER key.

¢ Type Email: info@

Fant e Paragraph o

e

doverpark.com and then P —'-]-m-.___h______-___r_,...#

press the ENTER key. I__--——-""_ _“I:mm“— " T—
¢ Press SHIFT+TAB to promote | a. + Monday-through-Friday—7:00-a.m.-to-7:00-p.m.q|

the current-level list item to a - L b.~ Saturday—7:00-a.m.-to-1:00-p.m.q|

higher-level list item (in this case, Firstdove st iten P ¢~ Sunday—Closed-(exceptfor-boarding pickup from 6:00 p.

converting c. to 3.). e 2. » Contact-Informationt)

R ——— 1 a. + Phone:-309-555-8282

¢ Type Payments as a first-level | demoted to el i 1' ;

Far= h =1 second-tevel list item b.~ Emaibi i feearh cainf) text -

list item, press the ENTER key, and 5 SRE———l, b vmentst entered

then press the TAB. ke.y to demote a. - Accepted-methods9]

the current-level list item to a .| should be demoted to b

lower-level list item (in this case, idieeeliatiitem -

converting 4. to a.). insertien paint

9 ) OURTEAMY
® Type Accepted methods e
ge Words
and then press the ENTER key = =
(Figure 4-46), Figure 4-46

7]

¢ Press the TAB key to demote the current-level list item to a lower-level list item {in this
case, converting b, toi.).

= Type Cash and then press the ENTER key.

* Type Check and then press the
ENTER key.

c. -+ Sunday=>
2.+ Contact-Informationy|

« Type Credit card and then 2.+ Phone:-309-555-82821)
press the ENTER key. b.~ Emalk: ¥
P 3.+ Paymentsq
® Press SHIFT+TAB to‘prc.)mote a.+ Accepted-methods?] ,
the current-level list item to a i, Cashg)
hlgher-l‘eve!.!lst item (in this case, il.+ Checkq]
converting iii. to b.). iil.+ Credit-cardy]
* Type the text for list item 3-b as b.- Full-payment-required-at-the-time-services-are-rendered .

’ . . ramainin
shown in Figure 4-47 and then 4.~ Discountsf) ] ket tems
press the ENTER key. a.- Frequentwisitor-ewards-cardq entered

e Press SHIFT+TAB to promote b.~ Fnen‘ds-and-famlIy-reft?rraI-programﬂ
5o ¢. » Multi-pet-household-discounts§
the current-level list item to a ) . )
. o . \ d.- Online-specials-through-our-website-and-Facebook-page§)
higher-level list item (in this case, N

. e, - Senior-citizen-ratesl]

converting ¢. to 4.).
# Finish entering the list as shown in .
s Figure 4-47

Figure 4-47,

* Save the proposal again on the same storage location with the same file name.
Other Ways

1. Type 1., pressSPACEBAR, type numbered list, pressing ENTER key at end of each item in list

Break Point: If you wish to take a break, this is a good place to do so. You can exit Word now. To resume at a later time, run Word,
open the file called Animal Clinic Sales Proposal, and continue following the steps from this location forward.
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1f you want text to wrap
around a table, instead

of displaying above and
below the table, do the
following: exther right-chek
the table and then ¢lick Table
Propertigs on the shartcut
menu, or click the Table
Properties button (Tabie Tools
Layout tab | Table group],
click the Table tab (Table
Properties dialog box), chck
Around in the Text wrapping
area, and then dick the OK
button

CONSIDER TH1S

To Show Gridiines

Editing and Formatting Tables

The sales proposal draft contains two Word tables: the sample fees table and the team
members table (shown earlier in the module in Figure 4 -26). The sample fees table
shows the sample fees for a variety of patient types, and the team members table shows
details about various staff members at the clinic. In this section, you will make several
modifications to these two tables so that they appear as shown in Figure 4-1 at the
beginning of this module.
The following pages explain how to modity the tables in the sales proposal draft:
1. Sample fees table
a. Change the column wideh for the column containing the type of services.
b. Change row heights so that they are not so tall.
¢. Shade wble cells.
d. Sort the table contents by service type.
e. Change cell spacing.
f. Change the column width of columns containing costs.
2. Team members table
a. Delete the extra column on the right edge of the table.

b. Split table cells so that the heading, Team Members, is above the second
column.

¢. Display textin a cell vertically 1 the lefrot the table.

d. Remove cell shading from the table.
e. Add borders to the wble.

£ Sum columns in the table.

Why should you include visuals in a sales proposal?

Studies have shown that most people are wisually oriented, preferring images to text Use tables to clarify ideas and illustrate
points. Be aware, however, that too many visuals can clutter a document.

O4F & FORMAT TABLES | & CREATE WATERMARK

When a table contains no borders or light borders, it may be difficult to see the individual cells in the
table. Thus, the following step shows gridlines. Why? To help identify the location of cells, you can display gridiines,
which show cell outlines on the screen. Gridlines are formatting marks, which means the gridlines do not print.

(1

o Display the table to be edited in the document window (in this case, the sample fees table).
 Position the insertion point in any cell in the table.
« Display the Tabie Tools Layout tab.

ssee

2828860868688
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Table Tooks and subordinate
“iew Table tabs automatically appear
Gridlines button when insertion point is in table

E@ % 7 & 13 S .. . 3T Hegnt .,,- "

Proptrtats  Draw  Erster  Delete  lnset bsert Inaert Insant & sﬁ‘sﬁ““‘“’“f}muﬂ

= If gridlines are

" not displayed on
the screen, click
the ‘View Table

Table Tools Layout tab

EEME =
I [ owtribute Cokomng QGET

Word Module 4

oo Table - Bbove Below Let Ry (o0 Coly  Tatls
Gl'ldllnES' bUttOﬂ N VD‘" Emh{'oﬁmij | gridlines show | (tl.siz:

LR L'|

£ © outlines of rows
(Table Tools Layout %+ Wellness:-Behavior and columns

tab | Table group) to . |. Table group
show gridlines in the « Sample-Feesq /

table (Figure 4-48). €
:

3

<  How do | turn off in_z::l:;ar:(ler 1igp:ays I
e ; o erstha
g table gridlines? E Initial-examit indicate begin ning and

Click the View Table S o
s , Well-wisitsi
Gridlines’ button
again. : Microchip- $40n $40n
= o ; implanty
::':jl?f services wrap Neuteri /AR 5851 $2001 $100u
Spayss NfAR $1600  $350m $125u
1 — -
Grooming- $20x $56x S60% N/AK
{midsize]x
Nail-trimt
Figure 4-48
. | !
To Cha nge COI umn Wldth | % EDIT B FORMAT TABLES | 6 CREATE WATERMARK

Notice in Figure 448 that the leftmost column containing the types of services is not wide enough to fit
the contents; that is, some of the services wrap in the cells. Thus, you will change the column width of just this
single column. Why? In this proposal, the services should appear on a single line that is just wide enough to accommodate
the types of services.

You can change a column width by entering a specific value on the ribbon or in a dialog box, or by using
a marker on the ruler or the column boundary. The following steps change column width by using a column’s
boundary.

(1)

# Position the pointer on the
column boundary to the right of
the column to adjust (in this case,
to the right of the first column}
so that the pointer changes to a
double-headed arrow split by two
vertical bars (Figure 4-49),

itz
Rows & Columns ”_“_’_‘,,f"’_' e
-‘-‘“""‘--.._--..._,. .

- .o L %] v i L I CRRE - !

T Wellness:-Behavioral-problem-guidance, nutritional-counseling,-and

= Sample-FeesY

Initial-examn 56(*’
Wellvisitsir ~ 990% $450 $45m

Microchip- + S40u $40 $40
Jmpraots ‘} painter on col

umn
Neuterh N/ boundary 5851 $200n

Figure 4-49
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2]

s Double-click the Table Tools Layout tab

column boundary so s button : R < o et e
that Word adjusts B T2 R evenwe L2 & ) MR g e B Dttt Rows Az
i Oti Grases Diear | Column’ Insert gt MR ¢

the col}.lmn width Prepesied{ D Lrmse s o e R et vt : o
according to the s e ; e ‘ Eg{: -c::,":,','; e

A TR . ' 1 L] ] . L 5 x

- st ! . . {d ’
column contents. (If % + Wellness:-Behavioral-prob ; riplonal-cou Img,..f\_”:.,af,w,ﬂare-check.upsq
all of the contents in “Table Column
Width' box shows

the Ct?lumn still are «Sample-Feest gﬁ::ir‘,’ifn?'”'"" ;f:,’us:e
not displayed on a * .. insertion paint
single line, double- FS
click the column )
boundary again so

that all contents are wellvisitst! $501 $45x 845K $300

insertion point

Initial-examit

displayed on asingle |
: , . . r $40n $40m 408
line) (Figure 4-50). Microchip-implantist > i
< What if | am using a Neutern 1 N/Ast $85H 5200 $100
& touch screen? " column wider to fit H $160n  $350M $125k w|
& Spayt services on a single
| line
: J Z/ Groomifgrdsizeft 7= $56H $60n N/Ax n
II | i IS —— ,_EIF I __'_'5125_ _$.1._0.E-~‘ Ay -—___H
Figure 4-50
£ Experiment
« Practice changing this column’s width using other technigues: drag the 'Move Tahle Column’ marker on the
horizontal ruler to the right and then to the left. Click the ‘Table Column Width’ box up and down arrows
(Table Tools Layout tab | Cell Size group). When you have finished experimenting, type 1.34 inthe Table
Column Width’ box (Table Tools Layout tab | Cell Size group).
Other Ways
1. Drag ‘Move Table Column’ marker 2. Enter desired value in ‘Table Column 3. Click Table Properties button (Table Tools Layout
on horizontal ruler to desired Width’ box (Table Tools Layout tab | Cell tab | Table group), click Column tab (Table
width Size group) Properties dialog box), enter width, click OK button

To Change Row Height

5 ED'T & TORMAT FABLES | 6 CREATE WATERMARK

The next step in this project is to narrow the height of the rows containing the services and fees. Why?

This table extends close to the bottont of the page, and you want to ensure that it does not spill onto the next page. (Note that

it already may spill onto a second page.)

You change row height in the same ways you change column width. That is, you can change row height by
entering a specific value on the ribbon or in a dialog box, or by using a marker on the ruler or the row boundary.

The latter two methods, however, work only for a single row at a time. The following steps change row height
by entering a value on the ribbon.

e Select the rows to change {in this case, all the rows below the first row).

g How do | select rows?
o

S8606008080808088

[ 3=
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* Click the ‘Table Row Height’ box up or down arrows (Table Tools Layout tab | Celi Size group) as many times as
necessary until the box displays 0.3” to change the row height to this value {or, if using touch, enter 0.3 in the

‘Table Row Height' box (Table Tools Layout tab | Cell Size group) (Figure 4-51).

Word Module 4

= Click anywhere to remove the selection from the table.

T = pre R e A
N BT IEE S ~
Select | View |Propetties | Draw Eraser  Delete | bsert dnsert et Ingest | Merge = e o 4 ‘Table Row Tot
- Pigfiges Table - Above Bebw Lt Right Cels Cef “Table Row |5 : Height' up and [reetion Marsies Jx Fommuda
Tabte Drew Rowt & Cohueca “ Height’ box e Sy down arrows et fats -
L AR U R DR T TR : - iR - . U R s s o ey B )
" ‘Adjust Table % P ] ; L
Row’ markers 5 Cell Size group || ?IH’I“ i
i - 4 current
Initial-examat $551 $550 alignment is
| top left
Wellvisitstt S50 $45n 545x -
- e e -] L
: Microchipimplants S0 saom  Saon S0 H
Neutert N/Ast $8SH  $200m $0m  m
: o e Spayt N/A $160m 350w $125n o
Grooming {midsizelit | 208 56 S60m /A n
Nall-timst $m $1m. $10 $15m "
: Fleabathit “ N/Au $150 $15u N/Ax H
. e
i L Boarding {pe with new row height, Facility heading S20m : Se00, #
may move to the bottom of this page;
. [v/ if necessary, you will insert a page
* Facili break here later in module -
Pagr2atl  sialaTwords 7 ] E_IE = (] . 1
Figure 4-51
Other Ways
1. Click Table Properties button 2. Right-click selected row (or, if using touch, 3. For asingle row, drag 4. Drag ‘Adjust Table
(Table Toois Layout tab | Table tap ‘Show Context Menu’ button on mini row boundary {horizantal Row' marker on
group), dick Row tab (Table toolbar), click Table Properties on shortcut gridline at bottom of row vertical ruler to
Properties dialog box), enter menu, click Row tab, enter row height (Table in table} to desired height desired height
row height, click OK button Properties dialog box), click OK button
BTW
Page Breaks
. . and Tables
To Align Data in Cells 00 00 et it  page
. \ ) . break 10 occur in the middle
The next step is to change the alignment of the data in cells that contain the of a table, pasition the
dollar amounts. Recall that, in addition to aligning text horizontally in a cell (left, insertion point in the table,
center, or right), you can align it vertically within a cell (top, center, or bottom). click the Table Properties
Currently, the doll have a top left ali (shown in Figure 4-51). I palton lege oot lL ot
urrently, the dollar amounts have a top left alignment (shown in Figure =2 tab | Table group), click the
this project, they should be aligned center so that they are more centered within the Row tab (Table Properties
row height and width. The following steps change the alignment of data in cells. dialog box), remove the

check mark from the *Allow
o . row to break across pages’
o Select the cells containing dollar amounts, as shown in Figure 4-52, check box, and then click the
) CK button. To force a table
g How do | select a series of cells? to break across pages at a
o Drag through the cells. particular row, click in the
row that you want to appear
on the next page and then
press CTRLHENTER,
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9 Click the Align Center button (Table Tools Layout tab | Alignment group) to center the
contents of the selected cells (Figure 4-52).

e Click anywhere to remove the selection from the table.

1 Tab|e Tools Layuut tab

= FliHeghe 93 T B Outobute Rows EEB é @ Al
ou- Eraser  Delcle  Insert lmat lnset bmet Mege Spit Splt Moﬂ e Width: ]

. TH Distrbure Colomns
Tabe - Above Boiow Lleh Rught  Cels Cels Table = :

Teat
73 h! E Ditectson Mugm

o Kerwrs s Colmmrn, o e Align Center |/ Migoment

button il \r- T

. Alignment

; v : 3

Ttop rownot | Initiatexamst $60H 4551 $551 a0 M
juirlected I well-visitsh S50u 4451 4451 $30 M
Microchip-implantis $40n S40n 40 saom M

Neutern N/Ax $asd $200% s100m M

Spayt N/AH $160K $350m $1258 B

Grooming: {midsize)n $20n $56n $601H N/an

Nail-trimst $7n $12n $10n s150 *°

Flea-bathit N/AR $15u $15u NAay R
Boarding{per-dayy $20u $20m $251 s20m "

cells selected and contents centered ]-____
| — .
© first column | .
not sefected | Figure 4-52

TO Shade a Table cell 5 EDIT & FORMAT TABLES | 6 CREATE WATERMARK

In this table, the cell in the upper-left corner of the table is to be shaded teal. Why? You want all cells in the
top row shaded the same color. The following steps shade a cell.

1]

it oy 2. Table Tools
# Position the . 150 LT i e s ¢ [EOEASOG
insertion point in T L T L ) 161 et
the cell to shade (in P~ Fefovm oo T P sE 5

o 5 E 'pt ,

this case, the cell in : - der Shiadcl‘n?‘ color to be
selecta

the upper-left corner

of the table). ' '.-| . : I l I g o Shading
¢ Display the Table : /
Tools Design tab. | :‘;ienr:wn Initial-exame LGER SGO!! SSS!. n a:; 21 No Color command
— o
Design tab | Table Microchip-implanty S40u A0 Sa0m 40
St‘y1e5 group) to _ Neutert N/An $85x $200n 51000
e T —m e
Figure 4-53
E' Experiment

« Point to various colors in the Shading gallery and watch the shading color of the current cell change.

1) i ] -'h?\':
8 8 @

L

‘
ot ]
.
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<t
a0
S
Lo . . C
o Click (A color o F 0 WL Chm (€1 the Shading gallery to apply the selected shading color to the b=
current cell (shown in Figure 4-54), T
o
<«  How do | remove shading from a cell? =
g. Click the Shading arrow (Table Tools Des No Color in the Sthading gallery.
!
TO Sort a Table 5 EDIT & FORMAT TABLES = & CREATE WATERMARK

The next task is to sort rows in the table. Why? The services should be listed in alphabetical order. The
following steps sort rows in a table.

o

 Select the rows to be sorted (in this case, all the rows below the first row}.

< |What if | want to sort all rows in the table?
g Place the insertion point anywhere in the table instead of selecting the rows

-e Display the Table Tools Layout-tab.
* Click the Sort button (Table Tools Layout tab | Data group) to display the Sort dialog box (Figure 4-54).

<L What is the purpose of the Then by area (Sort dialog box)?
g If you have multiple values for a particular column, you can sort by columns within columns. For example, if the
table had a city column and a last name cofumn, you could sort by fast names within cities.

i Table Tools Layout tab

'__;f—' .5-_- $ I Heght 0.3 . 3 pistribute Rows gg Aé_’ @
m Autoft 2 e T Distibute Columns IEIBEQ—.:‘;,.. Cet

K] Merge el Sage
L e = T [ | )
[ indicates to sort

m Sent on column 1 of 7 x
o Hn” | 5
ﬁl_-'l'l v Tpe Tet | @ ascending

cell shaded

I_nifiiln-«.zlx?mﬁ_-:' 25 'qm VIOn.mmﬂnurE 408 |1
ﬁf@ll-vusitsn J j v Trpe Tet ~ gllsmdmﬂ E o 5 5.3_'0_#. ._H
P —— : i rapraphs w Desceptiing P, .--.'
Microchipimplart . = sagy M
Newters | o T e S OORERA
TR My o pEmErE ]
;:I\:scted "’1 Spew‘i e "“]' (i Header jow @ o hender toyy E ﬁl_Z_Su_ .::
T : S
SRR o] a1 AR
Na—i'l:g‘:lg" "_"\. '-"I"l“r T -$7hﬂ et 512;:- H T A $10!1 515'" ! u
Feaatist, T /A S1s | $15m nya M
| Boarding-{per dayju $20n $20n $25n $20m ﬂ
® Facility9]
aTwords  {F oIl s - ]
Figure 4-54
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2

« Click the OK button (Sort dialog box) to instruct Word to alphabetize the selected rows.
¢ Click anywhere to remove the selection from the text {Figure 4-55).

Insert  Insert  Iosert IR

Above Below it Might
EY ’ ‘ 3
H 1 [ t o -
f Boarding(per-day)i $20m 5200 $2.5‘tl
Flea-bathn N/AR 515w $15m
- Grooming-{midsize)st $20u S56k S60u
Initial-examit S60k S551 455K
!_;g::g;“e““ Microchipimplanti 5401 S40K S40H
-] eronmn | Nailtriers $7u $121 $10x
7 A Neuter: N/ At $85H $200m
Spayt N/AK $1604 5350k
L Well-visitsi

Figure 4-55

To Select Nonadjacent ltems

EOROEMAT TAGLES | 6 CREATE WATERMARK

The next step is to select every other row in the table and shade it light teal. Why? You feel that using
shading on alternating rows will make it easier to vead acvoss individual rows. Word provides a method of selecting
nonadjacent items, which are items such as text, cells, or graphics that are not next to each other, that is, not to
the immediate right, left, top, or bottom. When you select nonadjacent items, you can format all occurrences of
the items at once. The following steps select nonadjacent cells.

o Select the first row to format (in this case, the row containing the Flea bath service).

(2

¢ While holding down

+ - S—— s rTREre
the CTRL key, select %’?5~ TR S og. oy
the next row to £ 531 SN A i ' o i 11 4
format (in this case, Boarding (per-day}# $208 5201 525u S0 M
the row containing Fiea-bathtd N/Au $15n $151 Nfan M
the Initial exam
service) to select the Grooming:{midsize)i $20m 5560 $60x N/An R
nonadjacent row. Initial-examm $60H $551 $55x $aon M
nonadjacent
» While holding rows selected Microchip-implantit $40u S40H SA0K sqoy M

down the CTRL key,
select the remaining
nonadjacent rows
(that is, the rows
containing the

Nail trim and Spay
services), as shown in
Figure 4--56.

Nail-trim

[E 20 A A

2 e SR N o /A $85k $200n $100¢
g e N/As $160n $350m $1250 ™

well-visitsk

Figure 4-56
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< Do | follow the same procedure to select any nonadjacent item?
g Yes. Select the first item and then hold down the CTRL key while selecting the remaining
items.

What if my keyboard does not have a CTRL key?
You will need to format each row individually, one at a time.

Word Module 4

To Shade Selected Cells

With the alternating rows selected, the next step is to shade them light teal. The
following steps shade selected cells.

o Display the Table Tools Design tab.

e With the rows selected, click the Shading arrow (Table Tools Design tab | Table Styles
group) to display the Shading gallery and then click a C i} |O 78 0 F OU-R
g (e in the Shading gallery to shade the selected rows‘wth the
selected color.

6 Click anywhere to remove the selection from the table (Figure 4-57).

BTW

- : erarty Table Headings
i - T _ T . If a table continues on the
E 2 = IIEIEORIIIZ OIIIIZ L e Border next page, you can instruct
o wf::;“:‘: S ; : "'"'?"‘"""" Word to repeat the table
PO bt = . S DE ? ¥ . headings at the top of
3 5 the subsequent page(s)

contairing the table. To do

F i iy ! e i 1 this, select the first row in
Boarding-(per-day}i the table and then click the

‘Repeat Header Rows' button
Flea-bathit {Table Tools Layout tab | Data
Grooming-{midsize}t group).
Initial-examt
ronadjacent Microchipimplantit
Nail-trimp
Neutertt
Spayit
Well-visitst
Figure 4-57
i i
To Change Cell Spacing |5 £0I7 & FORMAT TABLES | 6 CREATE wATERMARK

The next step in formatting the sample fees table is to place a small amount of white space between every
cell in the table. Why? You feel the table would be easier to read with shite space surrounding each cell. The following
steps change spacing between cells.

1)

¢ Display the Table Tools Layout tab.
* Position the insertion point somewhere in the table and then click the Cell Margins button (Table Tools Layout tab |
Alignment group) to display the Table Options dialog box.
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# Place a check mark
in the 'Allow spacing

between cells’ check im FHEE F1E ; T A ; o % Ag[ 04 |
. s 7 Ul = EEI E— i Celi Margins
Defete  inset ket | Ll Sphe e S . rnbute Columns oy o Tet  Cet=t—3m
box and then click e et losat T, e e [atic options 1 Drminte Cetumen o g T e button

the up arrow once
so that 0.02" is

| Table Tools
PR Layout tab

A e

Poow B L et . i

| dislog box
uk 8 - b

displayed in this box, ,TE'L'_’ % e
because you want O e tpten: ?
to increase space S20R  ovaun cenmmges
= op: 4 . et Of8 .
between cells by this Flea-bathil N/ A io:an v g ;:w ote % ;h;;ged o | Nfar H
Value (Figure 4- 58) . . . Drisull cell spaang . "
Grooming-{midsize}rt — Oxnt stow springpemeencom per® 3, OW N/AxX
ched X e
Initial-exami selected K col'_"l Antomaticoty a3t 1694 (or3eats 5u 540;1 e
Microchip-implanty 5404 [oc ) come gy 4o M
Nail-trimu $ m $12n $10m $15n M
Neuterlt N/AH $85Hk $200n stoom M
N/AR 5160u $350H s1258 P
$50n $45 $45K s30p M
—______“_'m-_'_d_._'_,_...--'"'_"_""" d_"——-.__\___| _F__'___'___..--'-"‘" "'""‘—-_.________

12

¢ Click the OK button (Table

Options dialog box) to
apply the cell spacing
changes to the current
table (Figure 4-59).

< Why are the column
g dividers in the first row

Figure 4-58

" Diaubts ComT

ey = T I T
o ol i, R AN § R

| space added
between cells 52(*
N/AK

Flea-bathat

wavy? Grooming:(midsize)n $20u
Initial-exam $60n
Microchip-implantt 4401
Figure 4-59
Other Ways

1. Click Table Properties button (Table Tools Layout tab | Table group),
¢lick Table tab (Table Properties dialog box), click Options button,
select desired options (Table Options dialog box), click OK button in

2. Right-click table {or, if using touch, tap ‘Show Context Menu’ button
on mini toolbar), click Table Properties on shortcut menu, click Table
tab {Table Properties dialog box), click Options button, select desired

each dialog box

options {Table Options dialog box), click OK button in each dialog box

To C_h_ange Coiu_mp Width

In reviewing the sample fees table, you notice that the columns containing the
fees are different widths. Thus, the final step in formatting the sample fees table is to
change the column widths because you want the columns containing the rates to all
be the same width, specifically .95”. The following steps change column widths by
specifying a value on the ribbon.
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Select the.columns to be resized, in this case, all columns except the first,

Click the ‘Table Column Width’ box (Table Tools Layout tab | Cell Size group) to select it.

e Type .95 inthe ‘Table Column Width' box and then press the ENTER key to change
the width of the selected table columns (Figure 4-60).

Click anywhere to remove the selection from the table.

¥ Table Tools Layout tab I BTW
B value entered in T
f 1o A i 1 03 able Columns
Tabie Column
;| width’ box it : HEE A IT | If you holdi down the
Moge Spit Splt Mot Iy or N width for sefected * i 0 =y ALT key while dragging
ﬁ-*]—"“—-'— 1 ¢tolumns changed #hctai b o a column marker on the
" Merg| Cell Size grou '—-.n-.u.
T eyl DMt o P o . ; e R ruler or a column boundary

in the tabie, the width
measurements of ail columns
appear on the ruler as you

Boarding {per-dayjt Sam $20 20 n drag the caolumn marker or
T — e : boundary.

Flea-bath LNl stse D g1se T NjAn B

Grooming {midsize)it $20x $56x 5600 N/an  H

Initial-examt I %em | $55y §558 | samm M

Microchip-implants $405 $401 Sam Sam M

Figure 4-60

To Page Break Manually

If the Facility heading appears at the bottom of the page below the sample fees
table, insert a page break immediately to its left so that this heading appears at the
top of the last page of the proposal (as shown in Figure 4-1 at the beginning of this
module}. The following steps insert a manual page break, if necessary.

o If the Facility heading is not on the last page of the proposal, position the insertion
point immediately to the left of the F in Facility.
e Display the insert tab.

9 Click the ‘Insert a Page Break’ button (Insert tab | Pages group} to insert a manual
page break at the location of the insertion point, which will move the Facility heading
to the last page of the proposal.

TO De'ete a c0|u m n 5 EDIT & FORMAT TABLES | 6 :CIIA'I'E WATERMARK

With the service fees table finished, the next task is to format the team members table, The tollowing steps
delete a column from a table. Why? The table in the draft of the proposal contains a blank column that should be deleted.

* Scroll to display the team members table in the document window.
¢ Position the insertion point in the column to be deleted (in this case, the rightmost column).

Word Module 4
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» Click the Delete 3 - By Delene
: s Table 5 4
Table button (Table ] button v - '
Tools Layout tab | Gt [ | o o :
Rows & Columns i rrovets e e N‘; Fre e i e ol
group) to display the e B e i i e
TR TR e b H L I Y
Delete Table menu P ol ini‘c-}ﬂ Rows & Columns | ki
1 = elete Columns group |
{Figure 4-61), ) s BpC = =T e backgibur o acaea -l
¥ icationdi i Jn-the- " & insertion point
e d dedgﬁglgi,ls_@g;l!ned in-the-table-that [reealliran %
| Delete Table ' ; e e e lete
- menu el MR PR T
# Click Delete Columns s ?"-fmf* T e
on the Delete Table S Caiiba ‘{“J‘"&‘f{“
3 L o k L - Th; o af “ n .. '-
menu to dele'fe_the __ i ) Ramosi  T,-Th,San n
column containing , _ - hdams§ M, T, ThFq
the insertion Veterinary. | . eich]  T,W,Th,Saq 3u H
point (shown in M,-W,-F, Sult
Figure 4-62). Gill T,"W,-Th,-5aq
g M, T, Th,Fq EFY o
Eetersond  M,"'W,-Fit
M,-T,-W,F}
L,_.._-..-—-—F"""‘“"_‘" AATh -
Figure 4-61
Other Ways
1. Right-click column to delete, click Delete Cells 2. Select colurmn, right-click selection, 3. If using touch, press and hold column to
on shortcut menu, click ‘Delete entire column’ click Delete Columns on shortcut delete, tap Delete Table button on mini
{Delete Cells dialog box), click OK button menu toclbar, tap Delete Columns

To DELETE A Row
If you wanted to delete a row, you would perform the following tasks.
1. Position the insertion point in the row to be deleted; click the Delete Table

button (Lable Tools Layout tab | Rows & Columns group) and then click Delete
Rows on the Delete "Table menu.

or

]

. If using touch, press and hold row to delete, tap Delete "lable button on mini
toolbar, tap Delete Rows.

or
3. Right-click the row to delete, click Delete Cells on the shorteut menu, click
‘Delete entire row’ (Delete Cells dialog box), and then click the OK button.
oar

4. Select the row to be deleted, right-click the selected row, and then click Delete
Rows on the shortcut menu.

To Split Cells I ;

| 5 EDT & FORMAT TABLES I 6 CREATE WATERMARK

The top, left cell of the table contains the text, Team Members. In the draft of the sales proposal, this row
is above the first two columns in the table (the job titles and employee name). This heading, Team Members,
should be above the descriptions of the employee names, that is, above the second column. Thus, you will split

the cell into two cells. Why? With the cell split, you can reposition the beading, Teant Members, above the second columm.
The following steps split a single cell into two separate cells.
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¢ Position the insertion
point in the cell to
split, in this case the
top left cell as shown
in Figure 4-62.

B NV oLl R e R S

# Click the Split Cells
button (Table Tools
Layout tab | Merge
group) to display the
Split Celis dialog box
(Figure 4-62).

(2]

= Verify the number
of columns and rows into
which you want the cell
split, in this case,
2 columns and 1 row.

= Click the OK button (Split
Cells dialog box) to spiit
the one cell into two
columns (Figure 4-63).

Other Ways

Dover-Park- AmmaI-Chmc-has
support-stafﬂaave ~the: backgrou group

table move
| handle
| L e T

contents in
leftmost cell
need to move
right one cell

Table Tools

=
°
=
T
o
=
o
e
=

Merge

The bach

is-outlined-|

Figure 4-62

single cel split

Split Cells
dialog box
t-foflows.

number of
columns and
TOWS & after split

TWTh,Sal

] Dr.-Lana-Canaanl

Dr. Raui ‘Ramosit

\ﬁﬂt Man Henre|ch1

T, Th -Saﬂ
Mt'Tr‘Thr'F‘
Tl 'w.r 'Th' 'Sﬂ‘

1. Right-click cell, click Split Cells on shortcut menu {or, if using touch tap ‘Show Context Menu’ button on mini toolbar)

To Move Cell Contents

When you split a cell into two cells, Word places the contents of the original cell
in the leftmost cell after the split. In this case, the contents (Teamn Members) should be

in the right cell. Thus, the following steps move cell contents.

o Select the cell contents to be moved {in this case, Team Members).

e Drag the cell contents to the desired location {in this case, the second cell in the first
rowy) {shown in Figure 4-64).

< What if | cannot drag the cell contents properly?

g Use the Cut and Paste commands.

BTW

Moving Tables

if you wanted to move a
table to a new location, you
would click in the table to
display the table move handle
in the upper-left corner of the
table (shown in Figure 4-63)
and then drag the table move
handle to move the entire
table to @ new location.

To Move a Cell Boundary

GE | 2 INSERT EXISTING DOCUMENT | 3 CREATE HEADER & ¢oOTER

L1575 | 5 EDIT & FORMAT TABLES | & CREATE WATERMARK

Notice in Figure 4~64 that the cell boundary to the left of the Team Members label does not line up
with the boundary to the right of the job titles. Why not? This is because when you split a cell, Word divides the cell
into evenly sized cells. If you want the boundary to line up with other column boundaries, drag it to the desired
location. The following steps move a cell boundary.
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o Position the pointer on the cell

boundary you wish to move so that the

pointer changes to a double-headed
arrow split by two vertical bars
{Figure 4-64).

« What if | cannot see the cell boundary? pointer on cel

g Be sure that table gridlines are

nal L | cell boundary not 2002, Ulrswe________veTiiarians-and-skieo-
the-backgral " vp correctly yr.petreceives thesbest i

boundary

showing: View Table Gridiines button

(Table Tools Layout tab | Table group).

(2

» Drag the cell boundary to the desired new location, in this
case, to line up with the column boundary to its right, as

shown in Figure 4-65.

Figure 4-64

S —— [ —
i n L 1 —_— '_'"'._._w-.

imal-Clinic-has-been-operational-sir] as you drag cell boundary,
vertical dotted ling

ave-the-background-to-ensure- indicates proposed location

-is-outlined-in-the-table-| of moved boundary

g What if | am using a touch screen? BRI i Sy ey e o Rk S
Position the insertion point in the upper-teft cell, tap the e — danad. M,-W,F§
Lo ' . P PP P cell boundary lines up é text lines upwith | T, Th, Sa
Table Properties button {Table Tools Layout tab | Table group}, | with column boundary rest of column :
tap the Cell tab (Table Properties dialog box), type 1.27 in 2o
the Preferred width box, and then tap the OK button. Figure 4-65
Other Ways

1. Drag ‘Move Table Column’ marker on horizontal ruler to desired width

To Distribute Columns

DIT & FORMAT TABLES | & CREATE WATERMARK

The next step in formatting the team members table is to make the width of the first three columns
uniform, that is, the same width. The following step distributes selected columns. Why? Instead of checking and
adjusting the width of each column individually, you can make all columns uniform: at the same tinme.

* Select the columns to format,
in this case, the three leftmost
columns.

# Click the Distribute Columns
button (Table Tools Layout tab |
Cell Size group} to make the
width of the selected columns
uniform (Figure 4-66).

< | How would { make all columns in
g: the table uniform?
Simply place the insertion point
| samewhere in the table before
i clicking the Distribute Columns
{ button.

| other Ways

¥ Table Tools Layout tab

Al Choisc Sahem Pipons - ¥ats

[ Lot Arrie e Visbrega Breerw e et ayout T Erine ket

= :‘-7 4 q I ij.. : ] .‘ ] - = gt Dutribine Rows
; ; n ; 2 Distribute E

Diie Giwsrs  Owbedp  bwindt Bl e Waesd Kimge Gpw ) g = ol
Tabte + ABow Briow Left RBghi b Col T, Rows button : e h“ﬁ k1!

O e & € e A Lieigr ey Gy .

3 X - i ¥ b
| Cell Ei:e_group Distribute Columns |
N

columns selected
and distributed

=y button

Dr.lanaCanaany M, W,

i) QI_’:RBI_I"RGM“ T-'Ib-'f@i-. ety 2
LatishaAdams§ M, T,7h,Fy "
‘MaxHenreich] T, W,Th,Sa9 3

& Camlyn MW, F,Sut
TeresaMcGIly T, W, ThSag "
leoMoretif M TThF§  3n

George-Petersomt | M, W, Rt
‘Dawn-NitzQ M, T, W, P
“ edVenwijkn T, W,Th,San

| e

7N =
mersi
e

Figure 4-66

1. Right-click selected columns, click ‘Distribute Colurns Evenly’ on shortcut menu (or, if using touch, tap ‘Show Context Menu' butten on mini toolbar}
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To DiSTRIBUTE ROWS

If you wanted to make rows the same height, you would perform the following tasks.
1. Select the rows to tormat.

2. Click the Distribute Rows button (Table Tools Layout tab | Cell Size group)
(shown in Figure 4-66) to make the width of the selected rows uniform.
' or

1. Right-click selected columns and then click ‘Distribute Rows Evenly’ on the shortcut
menu (or, if using touch, tap the ‘Show Context Menu’ button on the mini toolbar).

To Insert a Column

In this project, the left edge of the team members table has a column that
displays the label, Organization. Thus, the following steps insert a column at the left
edge of the table.

o Position the insertion point somewhere in the first column of the table,

e Click the ‘Insert Columns to the Left’ button (Table Tools Layout tab | Rows & Columns
group) to insert a column to the left of the column containing the insertion point
{Figure 4-67).

9 Click anywhere in the table to remove the selection.

Table Tools
- Layout tab

L 1 ~  i[Highs Elomibweton AR AT
column inserted | EEE =3 ¢
and selected e Merge s"“ S AR i 128 = Distribete Columns Tot el

E |r leht | Right  Cefs CeMs Table w! [ 2 iection Margins
1 P.oma:catunn blerge 0 fue i Adrgrment

I—' : .
! Rows & Columns %

group

e —————

A T AT TR T T Total

nberse 1 On SHes i s
Dr..Lana-Canaany M, W,-FJl 2 H
Dr.-Rau!-Ramosnt  T,-Th,-San
Latisha-Adams] M, T,.Th,F§ 4]
Max-Henreichq] T,W,-Th,-Saf] 3
Cam-Lyni M,'W,F,Sul
Teresa-McGill%) T,W,Th,5af| H
! Leo-Morettiq M,-T,-Th,-Fq 38
George-Petersontt  M,"W,-Fi
Dawn:Nitz§) M,T,-W,-Fq wm B

. T, -W,-Th,-§a§ )

Figure 4-67

To Merge Cells and Enter Text

The label, Organization, is to be displayed vertically to the left of the bottom
five rows in the table. To display this text, the five cells should be merged into a single
cell. The following steps merge cells and then enter text in the merged cell.

o Select the cells to merge, in this case, the bottom five cells in the first column of the table.

e Click the Merge Cells button (Table Tools Layout tab | Merge group) to merge the five
selected cells into one cell.

BTW

Draw Table

If you want to draw the
boundary, rows, and columns
of a table, click the ‘Add a
Table’ button (Insert tab |
Tables group) and then click
Draw Table in the Add a
Table gallery Use the penal-
shaped pointer to draw the
perimeter of the table and
the inside rows and columns.
Use the Table Eraser button
(Table Tools Design tab | Draw
group) to erase fines in the
table. To continue drawing,
click the Draw Table button
(Table Tools Design tab | Draw
group).

Word Module 4
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9 Type Organization inthe merged cell.

o If necessary, center the entered text (Figure 4-68).

= Table Tools Layout tab

IR

! El Distnbate Rows
mpeﬂ-n Dorn  Fraser tnsert  Insert  Insén lmm e Sp Gpld Awglnt =
Table o Above Below Left  Fught Ciri Table

D Rew B Calusnt % Meigs

711 Dustnbrute Coluwmng

Figure 4-68

1

To Display Text in a Cell Vertically

Dr ‘Lana- Canaanﬂ M W -Fq 71
g aF | Dr.Raul-Ramosyt T, Th,San
selected cells 7 ;; Latisha-Adams§]  M,T,Th,-F1 i
;?:'fl:fe'_"‘m : i p . MaxHenreich T, W,Th,Saq 3n
b text antered | Cam-Lynn M,-W,-F,-Sunt
S in cell and T il h
e o eresa-McGillq) T,"W,-Th,Saf ]
Leo-Morettiq) M, T, Th,-Fq 3
A i - George:-Petersonii M,-W,.Fit
: 5;.. R ' Dawn-Niteg M,T, W, Fq o M
_a.l"f' | Ed Vaankn T W -Th,San
¢ [P e T iy \. R u
i Total-Team Membersu 1 el L) ﬁ? N ¢
e 1 o, o ke di. oy a8 o * -

SEQIF & FORMAT TARLES | & CREATE WATERMARK

The data you enter in cells is displayed horizontally by default. You can rotate the text so that it is

displayed vertically. Changing the direction of text adds varicty to your tables. The following step displays text

vertically in a cell. Why? The label, Organization, is displayed vertically at the left edge of the table.

(1

¢ Position the insertion point in the cell that

Table Tools

t‘n.m

Direction
button

Toth 3

. ) Layaut tab
contalps tl:me text to rotate (in this case, T g gm . E[Eﬁ
Organization). s PR S oA Nt T 13 I darbeCom S b
L 1 - Abon e i
# Click the Text Direction button twice (Table hon ; e - T i T A.I.ig.nrr;t.a.nl i/‘i““‘
Tools Layout tab | Alignment group) so that Dover-Pack-Anim{  Kl.since-2002.-Our-staff-of-el group Fiansd 1ot
the text reads from bottom to top in the cell support-staff-have ur-pet-receives-the best possible-care Their
(Fi 69 and-dedication-is:
gure 4-69). C— ——
< | Why click the Text Direction button twice? LEE_:_...L_: .ﬁg i
o | The first time you click the Text Direction i;-ﬁ ¢ ;! il g: ;:T:::rs;ﬁ ?‘T\: s:l:
5 - |
button (Table Tools Layout tab | Alignment a&}&; _':l LatishaAdamsy  M,T.Th.Fq
group), the text in the cell reads from top to i . MaxHenreich  T,W,-Th,5af
bottom, The second time you click it, the text i *.—r-? Uk M, W, F, Sut
; . A Teresa:McGillq T, W, Th,-Saq
is displayed so that it reads from beottom to top L Sl | Leo-Morett ] M, T ThFq
{Figure 4-69). If you were to dlick the bution . George-Petersont  M,:W,Fn

a third time, the text would be displayed
horizontally again.

text direction
changed to vertical,

. bottom to top in

| current cell

"I Dawn-Nitz9
u EdVaanku

Figure 4-69
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o e )
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To Change Column Width

The cell containing the vertical text is too wide. Thus, the next step is to change
the width of that column. The following step changes column width using the ruler.

Word Module 4

o Drag the column's boundary inward, as shown in Figure 4-70, to resize the column.

< | Whatif | am using a touch screen?

g Position the insertion point in the column to adjust. Tap the ‘Table Column Width' box
{Table Tools Layout tab | Cell Size group), type .35 as the column width, and then
press the ENTER key.

column resized

ed-in-the-table-that-follows.§

T ; DA
lsuv OﬂSll
0 o e

Dr ‘Lana-Canaanyt M, W F1|
. i Dr.-Raul-Ramosk  T,-Th,-SaH
pointer ) _ Latisha-Adams M, T, Th,-Fq

on column

boundary ary: Max-Henreichq  T,-W,-Th,-Saf]

A Ted | Cam-LynH M,-W,F,-Sut

| Teresa:McGillf  T,-W,-Th,Sa9

| Leo-Morettif M,-T,-Th,-Fq
George-Petersonit M, W,-Fi

Dawn-Nitz9] M, T, W, -F§i

Figure 4-70

To Remove Cell Shading

In this table, only the first row and first column should have shading. Thus, the
following steps remove shading from table cells.

o Select the cells
that should not
contain shading
(in this case, all

i Shadi M
of the cells below  lowaon W SUCRCTTECTT 0092 "V o
the first row and Dover: Park first column  fhas-been-operational-since-2002.-0 - eterinarians-and- skllled
to the right of the ot selected cl@round ‘to-ensure-your-pet: recewi Ilii'i'ie -care. Their-experience:

first column). Smfﬂwm

€) Display the Table [fg;;;:m . TeamMembersi
Tools Design tab. PR B OME 5 M.W.F9

a-Canaang M, F1'.
Click the Shading a i

arrow {Table Tools | g
Design tab | Table & V eich T, W, N :

Styles group) SNSRI Camdynit M :

to display the S T o il el NS -
Shading gallery S Gl | e |

(Figure 4-71).

Figure 4-71
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e Click No Color in the Shading gallery to remove the shading from the selected cells
(shown in Figure 4-72).

o Click anywhere in the table to remove the selection,

To Hide Gridlines

You no longer need to see the gridlines in the table. Thus, you can hide the
gridlines. The following steps hide gridlines.

o If necessary, position the insertion point in a table cell.

BSREEER RN

9 Display the Table Tools Layout tab.

e Click the ‘View Table Gridlines’ button {Table Tools Layout tab | Table group) to hide
gridlines in the table on the screen.

To Border a Table

5 EQIT & FORMAT TABLES | & CREATE WATERMARK

The table in this project has a Y4-point, gold border around all cells. The following steps change the
border color in a table using the Borders and Shading dialog box. Why? Eavlier in this module when you created the
title page, the border line weight was changed to 6 point. Because the table border should be V2 point, you will use the Borders
and Shading dialog box to change the line weight before adding the border to the table.

» Position the insertion point

somewhere in the table, AR | Design tab i

¢l
&

3
1
.
:
]
:
.
:
1
:
1
.

.
!
.
1
A

ity

*
* Display the Table Tools Design 255 Boois ;:::: CEEES P o - 4
tab. Click the Borders arrow {Table s 7777 = = St LSRR Aol TR < i

Tools Design tab | Table Styles i ,J: at (y,'”_"'" o et g s i
; Table Styl 3 : o :
group) to display the Borders Dover-f_ 1229 2V 9P has o s andshasng '|ans-a
gallery. support-staff-have-the-ba
H i H and-ded Bord: d  pdin Settin Styte [—
» Click Borders and Sh.admg in the | Shading dialog | _ i B ; RN sy
Borders gallery to display the box A ] 7 urouttons 10 w001 selected settings
. N g = L
Borders and Shading dialog box. T

Borders  Puge Border  Jhading Thelr-e

- Bor

. i . i d Veteril ; ) Color arrow . 1 :
# Click All in the Setting area | LR :
{Borders and Shading dialog box), i 5 ; Certifi | L f
which will place a border on every R Veterll [ ™| R | 1
1 idth & §
cell in the table. E%J ] Technl 7 e "0 gl EJ S E R ;_
. . E;f_ . Veteril o o =1
= Click the Color arrow and then click oAl & ] -
‘Gold, Accent 5 {ninth color, first ' — E \d
row) in the Color palette to specify I point A iy ¥
. Ed-Yarkem T, W, Th, & —
the border color (Figure 4-72). i e z{ oK button | & @
o | — =1
» Click the OK button to place the Figure 4-72

border shown in the preview area
of the dialog box around the table cells in the document (shown in Figure 4-73).

&

| &
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Word can calculate the totals of rows and columns. You also can specify the format for how the totals will
be displayed. The following steps sum a column in the table. Why? In this project, the last row should display the sum
(total) of the values in the last column: Total Staff.

* Position the
insertion point in
the cell to contain
the sum (last row,
Total Staff columny).

o

* Display the Table
Tools Layout tab.

Word Module 4

Fermula

=

Formula =
byl Lot B Ak (2 wiese T EOwnest) dialog box e

Rows & Columny I} Marpe Cedl Sare ol Abgrument

: ; farmula automaticall
Park-Animal-Clinic-has-been-operational-sif, entered based on 4
«staff-have-the-background-to-ensure-you m;‘:’b‘;:: Aumbers in
dication-is-outlined-in-the-table-that-follows—g

AL L AT ] 1y T = Pyite bedsmk

# Click the Formula

v

Wi b et s } LI
T A R R U sk ndr vt L

button (Table Tools ok — -

— . Dr-lana-Canaan . M, W,F§ Lo loom -
Layout tab | Data %:;:i Veferinariansi Dr.RaulRamosH  T,Th,-San ' Frrrmerrenpreret _
group) to display - Certified- Latisha-Adamsq M, T, -Th,F§ n
the Formula dialog -1 | Veterinary- Max-Henreich§ T, W,Th,5a§ 3n @

box (Figure 4-73). f: Techniciansh Cam-Lynxt M,-W,-F,Sux

| Veterinary: Teresa-McGillq T,W,:Th,Saq B
< What is the formula 5 [ teoMorettil  M,T,Th-Fq 3n
g that shows in the George-Petersont  M,"W,-Fl

Formula box, and . w1 f DawnNitzg M, T, W,-F] o B
border in Ed-VanWijki T,W,-Th,-San

can i change it?

table changed |
Word places a . zgﬁg:rkergold rbersu I__._.immmmm.. b
d:‘zfaFuIt forlmsla in P T e e
the Formula box, .
depending on the Figure 4-73

location of the
numbers in surrounding cells. n this case, because numbers are above the currant cell, Word displays a formula that

will add the numbers above the current cell. You can change the formula that Word proposes, or type a different
formula. For example, instead of summing numbers you can multiply them,

©

® Click the Number T T e
Cels Tl . I =
format arrow e " u::. " T Lt Shmass it
(Formula dialog o R SRR - ok Pt PP o oo gy i e
box} and then click nimal-Clinic-has-been-operational-since-2002.-Our-staff-of-experts o r x| Number
. : | format

the desired format “have-the-background-to-ensure-your-pet-receives-the-best-possib remas o
for the result of the ion-is-outlined-in-thetable-that-follows. 4 l;_m’““”'m“
computation, in this

] format to be

FilEna H selected ';ﬁm v
Dr.Raul-Ramostt  T,-Th,Sax o Bl B sy R

case, the format
with the numeral 0
{Figure 4-74).

| Certified: Latisha-Adams®  M,T,Th,-Fq u
« | Why select the || Veterinary: MaxHenreich§  T,W,Th,Sa 3
g format with the gég Techniciansk Cam-Lynk M, W, F,-Sutt
mt i : ATh-
numeral 07 L"'E" Veterinary- :::::oxctg;lﬂ IAV.:."TT:?? . i
You want the result Lg' Assistantsi George-Petersontt M, W, Fi1

to be displayed as
a whole number, Figure 4-74
50 you select the

numeral 0. If you
wanted the result to display with cents, you would select the format #,##0.00 (the # symbol means to display a

blank if the number has a value of zero).
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o

® Click the OK button
{Formula dialog box)
to place the sum of
the numbers using
the specified format
in the current cell
(Figure 4-75).

Canisum a row
instead of a colurnn?

Q&A

if 1 make a change
to a number in a
table, does Word
automatically
recalculate the sum?

Instead of printing and
distributing a hard copy of a
document, you can distribute
the document electronically.
Options include sending the
document via email; posting
it on cloud storage (such as
OneDrive) and sharing the
file with others; posting it

on social media, a blog, or
other website; and sharing a
link associated with an online
location of the document.
You also can create and
share a PDF or XPS image of
the document, 5o that users
can view the file in Acrobat
Reader or XPS Viewer instead
of in Word.
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Figure 4-75

To Delete a Blank Paragraph

If you notice an extra paragraph mark below the team member table that it is
causing an extra blank page in the document, you should delete the blank paragraph. If
necessary, the following steps delete a blank paragraph.

o Press CTRL+END to position the insertion point at the end of the document.

e If necessary, press the BACKSPACE key to remove the extra blank paragraph and delete
the blank page.

9 If text spills onto a fourth page, remove space above paragraphs in the sales proposal
untit the entire proposal fits on three pages, as shown in Figure 4-1.

Creating a Watermark

The final task in this module is to create a watermark for the pages of the sales
proposal. A watermark is text or a graphic that is displayed on top of or behind the
text in a document. For example, a catalog may print the words, Sold Out, on top of
sold-out items. The first draft of a five-year-plan may have the word, Draft, printed
behind the text of the document. Some companies use their logos or other graphics as
watermarks to add visual appeal to their documents.
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To Create a Watermark P

In this project, the image of paw prints is displayed behind all content in the proposal as a watermark.
Why? The graphic adds visual appeal to the document, enticing readers to look at its contents. The following steps create
a watermark.

» Display the Design tab.

# Click the Watermark button
(Design tab | Page Background . .
group) to display the Watermark T BT S = —=a

= =i °Sd:s0dluﬂ ; ~
gallery (Figure 4-76). I:;",’,'e'i;'"""‘ i—- Contutents et

Page Background

=‘ Pummh Spacing *

DIMITCLA L -
rﬂ-\.._\\@"_/.::-. Viatemuriy Faem G o L |
[ Zuter Arerree. Remaove Watermark

x Lamous Aaersy 4——————— command removes
watermark from

I FeLL-SERVICE, - FRIFYDIY-

e document
ll:l’ﬂﬂ- YorR-PEFS!_
Figure 4-76
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o Click Custom Watermark in the Watermark gallery to display the Printed Watermark dialog box.

e Click the Picture watermark option button to select it (Printed Watermark dialog box), which enables you to select
an image for the watermark.

» Click the Select Picture button to display the Insert Pictures dialog box.

* Type paw prints inthe Search box and then click the Search button. Click the paw prints image shown in
Figure 4-1, or a similar image, and then click the Insert button to download the image and close the dialog box.
(Or, you can click the ‘Browse from a file' link in the Insert Pictures dialog box, navigate to the file called Colorful-
Paw-Prints-Pattern-Background-2400px.png in the Data Files, select the file, and then click the Insert button (Insert

Picture dialog box)).
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» Click the Apply button to show a preview of the watermark on the pages in the document window (Figure 4-77).

L_i A 2 Pacagraph Spacng * - A rE
Printed Watermark o i vt (b Etects - d
i R n Watermane P P
dialog box =-=t SRuT © T O st Detau Cn::' Borders
Demulferd | g Faue Badkgraung *
S 1. . 2 Picture
- watermark Prited Metcermark ER
i option button
selected ) Ho wotermark S
e Wt b 3.
Select Pucture .~ {2,.5 P bywnd - Patte i Back prown - 2 00pe. b i‘.——‘
J| setect Picture //** F42 ] B sasnen e file name of paw | oxe.t
9 beton CH g oot prints image
g 83 s o

—-—1 clicking Text watermark

| allows you to create a iy ? .
s watermark that contains !
Patients | custom text | Lot : : ‘

N tione B
— . P \ yvatern'.la.tk of p;w prints
- FOLL-SERVICE, FRIEKDLY - R TR R W inserted in document,
5 ) r 2 automatically sized to
CARE-FOR YOUR PETS/ fit page
— —
v _‘—_'“'“--__._ sty pe e ,d_.-ﬂ"“"'-dﬂ_“d“
Figure 4-77
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e Click the Close button (Printed Watermark dialog box} to close the dialog box.

g How do | remove a watermark from a document?
o

How do i create a text watermark?

Other Ways

1. Click ‘Explore Quick Parts* button {Insert tab | Text group), click ‘Building Blocks Organizer’ on Explore Quick Parts menu, select desired
watermark (Building Blocks Organizer dialeg box), click nsert button

Wi, —

To Change Theme

6 CREATE WATERMARK

The final ¢ [ ynts used for text in the document. Why? With
the watermark, som ;

and body text fonts,
set. A font set defines téxt. The default font set is Office, which uses
the Cambria font for heady
20 predefined, coordinate

seees8e

il

R 28

142
3

& & & M
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o Click the Theme Fonts button 2
ok Design tab
(Design tab | Bgcument Formatting e T L _ (i
group} to display*the Theme Fonts
gallery (Figure 4-78

@ Experiment

* Point to various font sets in the
Theme Fonts gallery and watch
the fonts of text in the document
change.
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Theme Fonts
Sl button

© @ 9 9B @@

2

» Scroll through the Theme Fonts

gallery and then click TrebuchetMs
in the Fonts gallery to set the
document theme fonts to the
selected font (shown in Figure 4-1
at the beginning of this module

FULL-SERVICE, - FRIFNDLY

< | What if | want to return tgfhe CARE FOR FOUR PETS!

g default font set?
You would click theTieme Fonts
{button and thenick Office in the
'Fonts gallery,

Figure 4-78

s If necessATy, insert a page break
befgee the Facility heading. Make any additional adjustments to spacing, table colum
document looks like Figure 4-1 shown at the beginning of this module.

WO =S O e W

To Check Spelling, Save, Print, and Exit Word

The following steps check the spelling of the document, save and print the
document, and then exit Word.

o Display the Review tab. Click the "Spelling & Grammar’ button {Review tab | Proofing
group) to begin the spelling and grammar check. Correct any misspelled words.

o Save the sales proposal again with the same file name.

3. Submir your assignment as incbaucted.

Summary

In this module, you learned how to add a border to a paragraph, change paragraph
indentation, insert and format a SmartArt graphic, apply character effects, insert a
section break, insert a Word document in an open document, change theme fonts,
insert formatted headers and footers, sort lists and tables, modify and format existing
Word tables, sum columns in a table, insert a watermark, and change theme fonts.
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Conserving Ink and
Toner

if you want to conserve ink
or toner, you can instruct
Word to print draft quality
documents by clicking File
on the ribbon to open the
Backstage view, clicking the
Options tab in the Backstage
view to display the Word
Options dialog box, clicking
Advanced in the left pane
(Word Options dialog box),
scrolling to the Print area

in the right pane, placing a
check mark in the ‘Use draft
quality’ check box, and then
clicking the QK button. Then,
use the Backstage view to
print the document as usual.
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What decisions will you need to make when creating your next proposai?
Use these guidelines as you complete the assignments in this module and create your own proposals outside of this class.

1. Identify the nature of the proposal.

a} If someone else requests that you develop the proposal, it is solicited. Be sure to include all requested information in
a solicited proposal.

b) When you write a proposal because you recognize a need, the proposal is unsolicited. With an unsolicited
proposal, you must gather information you believe will be relevant and of interest to the intended audience.

2. Design an eye-catching title page.

a) The title page should convey the overall message of the sales proposal.
b) Use text, graphics, formats, and cclors that reflect the goals of the sales proposal.
¢) Be sure to include a title.

3. Compose the text of the sales proposal.

a) Sales proposals vary in length, style, and formality, but all should be designed to elicit acceptance from the reader.
k) The sales proposal should have a neat, organized appearance.

) A successful sales proposal uses succinct wording and includes lists for textual messages.

d) Write text using active voice, instead of passive voice.

@) Assurne that readers of unsolicited sales proposals have no previous knowledge about the topic.

f) Be sure the goal of the proposal is clear.

g} Establish a theme and carry it throughout the proposal.

4. Enhance the sales proposal with appropriate visuals,

a) Use visuals to add interest, clarify ideas, and illustrate points.
b Visuals include tables, charts, and graphical images it.e., photos, etc.}.

5. Proofread and edit the proposal.

a) Carefully review the sales proposal to be sure it cantains no spelling, grammar, mathematical, or other errors.

b) Check that transitions between sentences and paragraphs are smooth. Ensure that the purpose of the proposal is
stated clearly.

) Ask others ta review the proposal and give you suggestions for improvements.

Apply Your Knowledge

Reinforce the skills and apply the concepts you learned in this module.

Working with a Table

Note: To complete this assignment, you will be required to use the Data Files. Please contact your
instructor for information about accessing the Data Files.

Instructions:  Run Word. Open the document called Apply 4 -1 Projected College Expenses
Draft located on the Data Files. The document contains a Word table that you are to modify. The
modified table is shown in Figure 4-79.
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Four-Year Projection o
Freshman Sophomore Junlor Senior Total 'z'
Books & Supplies $950 $1,000 $1,050 $1,100 $4,100 5
4
Miscellaneous $2,000 $2,500 $3,000 $3,500 $11,000 U
Vi
Phone $55 $55 $55 $55 $220 e
Room & Board $8,250 $8,250 $8,250 $8,250 $33,000 S
[*Y)
Tuition $13,500 $14,000 $14,500 $15,000 $57,000 E
-
Total $24,755 $25,805 $26,855 $27,905 $105,320 g

Figure 4-79

Perform the following tasks:
I. Show gridlines.

oW

wn

10.

11.
12.
13.

. Delete the blank column between the Junior and Senior columns.
. Use the Distribute Rows command to evenly space all the rows in the table.
. Use the Distribute Columns command to make the Freshman, Sophomore, Junior, Senior, and

Total columns evenly spaced.

. Change the width of the Freshman, Sophomore, Junior, Senior, and Total columns to 1”.
. Use the Formula button (Table Tools Layout tab | Data group) to place totals in the bottom

row for the Freshman, Sophomore, Junior, and Senior columns. The totals should be formatted
to display dollar signs (no cents). Hint: You will need to edit the formula and remove the .00
from the end of it.

. Use the Formula button (Table Tools Layout tab | Data group) to place totals in the right

column, also formatted to display dollar signs (no cents). Start in the bottom-right cell and
work your way up the column.

. Add a row to the top of the table. Merge all cells in the first row into a single cell. Enter the

title, College Expenses, as the table title. Change the alignment to Align Top Center.

. Split the cell in the first row into two rows (one column). In the new cell below the title, enter

the text, Four-Year Projection, as the subtitle.

Shade the first row Purple, Accent 4, Darker 25%. Change the font color of text in the first row
to White, Background 1. Shade the second row Purple, Accent 4, Lighter 80%.

Add a 1 pt, White, Background 1, Darker 50% border to all cells in the table.

Hide gridlines.

Change the height of the row containing the year-in-college headings (row 3) to 0.1". Change
the alignment of these headings to Align Top Center.

Continted >
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Apply Your Knowledge rontiined

14.
15.
16.
17.
18.
19.

20.

21.

Change the height of all expense rows and the total row (rows 4 through 9) to 03"
Change the alignment of the cells in the first column to Align Center Left.

Change the alignment of the cells containing dollar amounts to Align Center Right.
Center the entire table across the width of the page.

Sort the rows containing the expenses.

If requested by your instructor, add your last name to the first row of the table before the
words, College Expenses.

Save the modified file with the file name, Apply 4~ 1 Projected College Expenses Modified, and
submit it (shown in Figure 479} in the format specified by your instructor.

€7 Which number format did you use in the Formula dialog box in #6 in this exercise? Why do
some totals have a space after the dollar sign and others do not? Which formula appeared in #72

Extend Your Knowledge

Extend the skills you learned in this module and experiment with new skills. You may
need to use Help to complete the assignment.

Using Word's Draw Table Feature
Instruetions:  Run Word. You will use Word’s Draw ‘Table feature to draw a table.

Perform the following tasks:

1.
2.

table using |
Draw Table |,
button

pencil

Sdaghe gt

- : | 15 Im | = i
create this ?'.::'t Bt 249 columns for [ 2T ' Hand Wash | 4ems | Wash and Wax Fehere Complete . T

| pointer |

Use Help to learn about Draw “lable and text watermarks.

Draw the table shown in Figure 4-80. That is, use the Draw Table button to create the blank
table.

Bl e Table Eraser [Eiatteiitiss s o TR

% button to erase [N T v (R ¢ [ud e i i b 2 Fryey AR
unneeded lines 1 P e, i
):l:' 2 e £ ! 4 e, 5T " E Ghstinte Bow } . T Al [ Repeat Header Psss

¥ p Comvertta Tea

o b g - ; Ji b
i ruwhe.-:dnm_;sI .| column column Detail colurnn -

. A . o \ . \ R e T

\ 1 row for
column
/ headings

rows for
compact,
&~ midsize, and
| full-size cars |

row for
La—"] trucks/SUVs

\ row for
multiple

vehicle

discount note

- T, S,

Figure 4-80
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3. In the top row, enter these headings in the columns: Type of Vehicle, Hand Wash, Wash and
Wiax, and Complete Detail. ]

4. In the leftmost column of the table, enter the text, Car, so that it displays vertically in the cell.

5. In the second column of the table, enter these labels in the second, third, and fourth rows (to
the right of the vertical text, Car): Compact, Midsize, and Full-size. Enter these labels in the
bottom two leftmost rows: Truck/SUV and Multiple vehicle discount.

6. For the Hand Wash column, enter $50 in the cell to the right of the Compact, Midsize, and
Full-size rows.

7. For the Wash and Wax column, use this data for the table: Compact — $100, Midsize - $115,
Full-size - $120, and Truck/SUV - $150.

8. For the Complete Detail column, use this data for the table: Compact - $225, Midsize - $250,
Fuli-size - $300, and Truck/SUV - $375.

9. Enter the text, $20 savings per vehicle serviced in a single month!, in the rightmost bottom row.
10. Align and shade table cells, along with any other relevant enhancements, as you deem
appropriate (alignment, shading, etc.).
11. If requested by your instructor, enter your name below the table.

12. Save the revised document using the file name, Extend 4-1 Car Wash Table, and then submic it
in the format specified by your instructor.

13. €3 Which alignment and shading for the table cells did you choose and why?

Expand Your World

Create a solution that uses cloud or web technologies by learning and investigating on
your own from general guidance,

Using Word Online to Create a Table

Instructions:  You are using a mobile device or computer at school that does not have Word but
has Internet access. To make use of time between classes, you use Word Online to create a table
showing your volunteer service (Figure 4-81).

Perform the following tasks:
1. Run a browser. Search for the text, Word Online, using a search engine. Visit several websites
to learn about Word Online. Navigate to the Office Online website. You will need to sign in to
your OneDrive account.

2. Create a new blank Word document using Word Online. Name the document Expand 4-1
Volunteer Services. Change the zoom to page width.

3. Enter and format the table, as shown in Figure 4-81.

4. Apply a table style to the table (any style).

5. Change colors of the table to a color other than blue.

6. Remove the First Column shading (Table Tools Layout tab | Table Style Options group).

Continued >
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Expand Your World continted
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| table created |

| using Word

On_lll_'l_e
Or!nllmmon Primary Responsibility Term of Service
Blue Valley School District Tutor 6 years
Jasper County Youth Groups Team Leader 3 years
Kirkland Park District Special Events Vocalist 2 years
Ridgeland Athletic Club Baseball Coach 4 yearsl 1

PAGE 1OF ¥ ABOUT iﬁm ENGLISH .5 SAVED 1O CHEDRAE I

Figure 4-81

7. Narrow the width of the last column to fit the contents better and then change the cell
alignment in this column to Align Top Center. How did you adjust the column width?

8. Add a row to the bottom of the table that identifies volunteer service you have performed.

9. Save the document again.

10. Submit the Expand 4~ 1 Volunteer Service document in the format requested by your instructor.
Sign out of your OneDrive account.

11. €3 Which table features that are covered in the module are not available in Word Online?
Answer the question posed in #7.

In the Labs

Design, create, modify, and/or use a document following the guidelines, concepts, and
skills presented in this module. Labs 1 and 2, which increase in difficulty, require you to
create solutions based on what you learned in the module; Lab 3 requires you to apply
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Lab 1: Creating a Proposal with a SmartArt Graphic,
a Bulleted List, and a Table

Note: "To complete this assignment, you will be required to use the Data Files. Please contact your
instructor for information about accessing the Data Files.

Problem: "The owner of Java Junction has hired you to prepare a sales proposal for her coffee shop -~
(Figure 4-82).

Perform the following tasks: 2 C 01 0 . .
1. Change the document ‘theme to N ounr Ch 01Ce.

2. Change the theme fonts to the Tw Cen MT-Rockwell font set.

3. Create the title page as shown in Figure 4-82a. Be sure to do the following: 2 N ow plck.

a. Insert the SmartArt graphic, add text to it, and bold the text. Change the colors and style of
the SmartArt graphic as shown. Change the spacing above the SmartArt graphic to 42 points
and the spacing after the graphic to 54 points.

b. Change the fonts, font sizes, and font colors as specified in the figure. Add the paragraph
border. Indent the left and right edges of the title paragraph by 0.25 inches and the left
and right edges of the paragraph below the SmartArt graphic by 0.5 inches. Expand the
characters in the sentence at the bottom of the page by 7 points.

4. At the bottom of the title page, insert a next page section break. Clear formatting.

5. Create the second page of the proposal as shown in Figure 4—82b.
a. Format the Heading 1 style as shown and update the Heading ! style accordingly.
b. Enter the multilevel list as shown.

c. Create the table as shown. Border the table as specified. Distribute rows so that they are
all the same height. Change the row height to 0.21 inches. Center the table between the
margins. Change the first column’s alignment to Align Top Left the text, and all other text
in the table to Align Top Center. Shade the table cells as specified. Change cell spacing to
0.04 inches between cells.

d. Insert the formatted footer using the Blank (Three Columns) design. The footer should
appear only on the second page (section) of the proposal. Enter the footer text as shown.

Change the phone number in the footer to your student
D#.
6. Add a picture watermark of the coffee beans. The picture is located on the Data Files. Scale the
picture to 50% in the Printed Watermark dialog box.

7. Adjust the spacing above and below paragraphs as necessary to fit all content as shown in the
figure.

8. Check the spelling. Save the document (1§ L Q¢YNAME Lab \ o€ Last Name J-GVG\ I\AY\ 01'.\0 n.

Continued >
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Inv the Labs centinied

| 3-pt box border (third |
from bottom in Style

list); color: Orange,
Accent 2 J

unction
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| [ shading color Brown, |
72-point Gil Sans Ultra
| Bold Condensed bold | L fu:cent 3 L'_g_"!‘ieo_’_"
font; color: Brown, |
Accent 3, Darker 25%

i SmanAn graphic -

léa;;out gr]-ddmru:: ol Delicious Fast
olors: Colorful - Accent Colors g B
Style: Intense Effect Coffee Service
. Text: Bold
L. e T
Reasonable
coffee beans Pl'iﬂes_'
| wa(ermark #

36-point Gil Sans MT
bold italic font; color:

Crange, Accent 2,
Darker 50%

\Stop by today to
~enjoy the best —
coffee in town!

—

Figure 4-82 (a)
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Heading 1: 14-point
Rockwell bold italic
fant; color; Orange,
Accent 2; centered

2 S

1) FreshBrowed
a) Light, medium, or dark roast
b) Hotor iced
c) Regular or decaf
2) Espresso - Hotor Iced
a) Cappuccino
b) Latte or macchiato
1) Caramel, cinnamon, hazelnut, or vanilla
ii) Sugar-free caramel or vanilla
c) Mocha
1) Regular or sugar-free

T 3) Blended Beverages

nst."b:aT'—- a) Java coolers

LA ! § 1) Caramel,chocolate, orvanilla _
bh) Smoothies

{) Banana, orange, peach, or strawberry

Word Module 4

We have a varled menu for all coffee connoisseurs!
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i) Cups
(1) Small - 12 ounce
(2) Medium ~ 18 ounce
(3) Large — 20 ounce
b) Milk
i) Skim, 2%, whole, coconut, almond, or soy

-

Our prices are reasonable!

Ya-pt border; color:

o . Accent 2 " : hading: Orange,
range, Accen P:ces of Popular Items _ Accent 2, Darkar 50%
Small’ ' Medium ' ' Large
Brewed coffee $1.80 $3.00 $2.80
m $1.68 $2.35 $2.768 shading: Brown,
0o s |
Chocolate java cooler $2.76 $3.28 $3.78
BTN s v s
3800|3280, 8300 | Kot s o
| Vanilla Jatte 32.80 $3.00 $3.50

Order online, stop in, or call ahead!

info@ij.net "

656-588-3300 www.javajunction.com

Figure 4-82 (b)

——
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In the Labs continued

Lab 2: Creating a Proposal with a SmartArt
Graphic, a Complex Table, Picture Bullets,
and a Numbered List

Problem: The owner of the A-Plus Tutoring has hired you to prepare a sales proposal that
describes the center (Figure 4-83).

Perform the following tasks:
{. Change the document theme t(m theme. (0 lo |78 OF \l dUR cho f ce .

2. Change the theme fonts to the Franklin Gothic font set.
3. Create the title page as shown in Figure 4-83a. Be sure to do the following:

a. Insert the Vertical Equation SmartArt graphic, located in the Relationship category.

b. Change the fonts, font sizes, font colors, and shading as indicated in the figure. Indent
the left and right edges of the title paragraph by 0.5 inches. Expand the characters in the
sentence at the bottom of the page by 7 points.

4. At the bottom of the title page, insert a next page section break. Clear formatting.
5. Create the second page of the proposal as shown in Figure 4-83h.
1. Insert the formatted header using the Banded design. The header should appear only on the

second page of the proposal. Enter the header textas shown.

b. Add your name to the header. (Nr\-h A-Plug Tuto D.S)

¢. Format the headings using the heading styles specified. Adjust spacing before the Heading 1
style to 18 point and after to 6 point, and before the Heading 2 style to 12 point and after to
6 point. Update both heading styles.

d. Create the bulleted list using the picture bullets shown (search for the keyword, star, or use
the image on the Data Files).

¢. Create the multilevel numbered list as shown.

f. Create the table as shown. Distribute rows so that they are all the same height {about 0.297).
Align center all text except the row headings, which should be set to Align Center Left.
Center the table. Change the direction of the Weekdays heading as shown. Shade the table
cells as indicated in the figure.

6. Create a text watermark of 10 occurrences of the text, A+, with each occurrence separated
by a space. In the Printed Watermark dialog box, change the watermark to 48-point
Verdana with a semitransparent color of Blue-Gray, Text 2, Lighter 60%. The layout should
be diagonal.

7. Tf necessary, adjust spacing above and below paragraphs to fit all content as shown in the figure.
Check the spelling of the proposal..

€. Save as: Lasrname Lo 2 0R Lastname APIWSE T whons.
B. Cwpir a8 increveted.
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| 72-point Rockwell |
Extra Bold font;
colar: Yellow

72-point Rockwell
| Extra Bold font;

color: White,

Background 1
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shading color and —J

6-point box border
% ' color: Orange, -
. r Accent 4 G i
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72 -point Rockwell S
Extra Bold font, ST - . SmartArt graphic - — L
ei6T Ofange, Type: Relationship
| Accent 4 Layout: Vertical Equation
Colors: Colored Fill - Accent 2
Your Hard Style: Intense Effect
I - Work and S
13-point Franklin Dedication

i Gothic Book font

Academic
Success

" | 30-point Franklin
Gothic Book font

;[ Call §55-1287 to e
-/ schedule a free '

color: Orange,
taxt

== futoring session!

——

Fig;.lre 4--83 {a)

Continued >




STUDENT ASSIGNMENTS

WD 254 Word Module 4 Creating a Document with a Title Page, Lists, Tables, and a Watermark

In the Labs contiisied

header
IR

i "
picture

builets

[
| multilevel |
numbered

Convenience

OUR CENTER

A-Plus Tutors is committed to providing the highest quality tutoning services All of our tutors are
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Wa offer tutoring in a variety of subjects. Below are soms of the more popular sessions.
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b} Math
i) Core: algebra. gaomstry
ii}Other: calculus, precalculus, statistics. trigonomatry
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d} World Languages
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3} College prep
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Lab 3: Consider This: Your Turn

Create a Proposal for a Small Business

Note:  To complete this assignment, you will be required to use the Data Files. Please
contact your instructor for information about accessing the Data Files.

Problem:  As a part-time employee at a local deli, you have been asked to design a
multipage sales proposal that can be distributed in the community.

Part: The proposal should contain a title page, followed by a page of information
about the deli. The ttle page is to contain the deli name, Delj Delicious, formatted
with a border and shading. Include an appropriate SmartArt graphic that contains
these words, at a minimum: fresh ingredients, reasonable prices, fast service, and dine
in or carry out. Include this text on the title page: Stop by, call ahead, or order online!

The source content for the second page of the proposal is in a file called Lab 43
Consider This Your Turn Deli Draft. Use the concepts and techniques presented in this
module to create and format the sales proposal. Include an appropriate watermark. Be
sure to check the spelling-and grammar of the finished document. Submit your
assignment in the format specified by your instructor.

Part2: €)) You made several decisions while creating the sales proposal in this
assignment: how to organize and format the dtle page (fonts, font sizes, colors, shading,
styles, etc.), which SmartArt graphic to use on the title page, and how to organize and
format the tables and lists. What was the rationale behind each of these decisions? When
you proofread the document, what further revisions did you make and why?

Word Module 4

STUDENT ASSIGNMENTS







